
Volume Extractor Version 3.0 Operation Manual i 

 

 

 

3D Image Visualization System 
 

Volume 

Extractor  

  
Version 3.0 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

i-Plants Systems Limited Company 



Volume Extractor Version 3.0 Operation Manual ii 

Forewords 
In recent years, with rapid improvement in high speed computer performance, 3D image 

that once could only be processed at work station has become accessible now. 3D image has 

greatly extended its use from industry field to entertainment domain. Its application in 

simulation games and CAD is also being developed. In addition, 3D image reconstruction 

with CT has been applied to mummy ruins of archeological discoveries and simulation of 

generated cross-section for non-destructive inner examination. It can be said that 3D image 

has been very active in every aspect of our daily life. 

 

In medical field, 3D image in CT/MRI has been widely acknowledged and used. Image 

diagnosis has been used for operation plan and informed consent. Even intermediate 

hospitals have been equipped with CT/MRI and small dental departments have started using 

CT. In addition, OCT has also been introduced into medical field. All of the above 

mentioned needs to output a large amount of tomographic image data. In order to make full 

use of tomographic image data and make them much more visual, it is necessary to transfer 

2D image group set into 3D image, so high-end workstation and professional software are 

indispensable. 

 

Volume Extractor is designed for processing medical images. As long as Windows systems 

are available, 3D reconstruction can be simply performed by inputting DICOM image. 

Besides this, any specified part or crossed section can be viewed from a variety of angles 

and used to generate real model with the help of PR apparatus for data output. The beginning 

user of Volume Extractor is able to skillfully process 3D images and perform various 

functions at simple operation guide. 

 

Feel free to use simple and handy 3D image tool of Volume Extractor.  
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1.1 Install 
Installation Software Program of Volume Extractor 3.0 will install utility software and start 

controller on your computer. 

 

1.1.1 Starting Installation Program 
Installation by downloading: open the downloading file and double click setup.exe starting 

installation program. 

 

Installation from CD: insert CD and the installation software of Volume Extractor 3.0 will 

automatically get started. 

 

※ If CD automatic playing does not work, open the disk driver, double click setup.exe and 

start installation program. (As shown in figure 1.1.1) 

 

 
Figure 1.1.1 Starting Install Program  

 

1.1.2 Essential Components To Be Installed  
After the installation program in 1.1.1 gets started, a dialogue box will appear, telling you 

that ".NET Framework 4.0" is being installed. The one controller must be installed when 

Volume Extractor 3.0 is in operation. Click the dialogue box saying "Install" button. (As 

shown in Figure 1.1.2) 

※ The Controller Installation dialogue box will not appear once it has been installed. 
 

 
Figure 1.1.2 Installation of Essential Parts  
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1.1.3 Application Installation 
Related parts can be installed after the essential parts are finished with installation.  

(As shown in Figure 1.1.3) 

 
Figure 1.1.3 Installation Screen (1)  

 

Click "I accept the terms in the license agreement", and then click "Next" button.  

(As shown in Figure 1.1.4) 

 
Figure1.1.4 Installation Screen (2)  

 

Click "Next" button. (As shown in Figure 1.1.5) 

 
Figure1.1.5 Installation Screen (3) 
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Click "Next" button and perform the installation (As shown in Figure 1.1.6) 

 

 
Figure 1.1.6 Installation Screen (4), (5) 

 

After installation is finished, it will make shortcut on Start Menu and the desktop. 

(Figure1.1.7) 

 

 
Figure 1.1.7 Installation Screen (7), (8), (9) 
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1.2 Uninstall  
 

Uninstall is done from "Add and Remove Program" on Control Panel.  

(As shown in Figure 1.2.1 and 1.1.2) 

※ when uninstalling Volume Extractor 3.0, choose "Remove" to delete the application 

program of "Volume Extractor 3.0", but ".NET Framework 4.0"and "VC++"cannot be 

uninstalled. 

 

 
Figure1.2.1 Display Control Panel 

 

 
Figure1.2.2 Add / Remove Program Screen 
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In the "Add / Remove Program", when you select "Remove Volume Extractor 3.0", the 

confirmation dialogue box will appear. Then Click "Yes" when you uninstall.  

(As shown in Figure 1.2.3) 

 

 

 

 

 

 

 

 

 

 
Figure1.2.3 Uninstall Confirmation Dialogue Box 

 

*1.2 Warnings on Uninstallation 

All the documents in Cache and Edit cache file saved inside the 

application program will be deleted when uninstall is 

performed. Cache and Edit cache are the files used in program 

running, so the data stored in them will not be saved. 
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1.3 System Requirements 
 

Category 
Essential  

Environment 

Recommended  

Environment 

OS Microsoft® Windows® XP Professional 
*1.3

  

Microsoft® Windows® Vista 
*1.3

  

Microsoft® Windows® 7 
*1.3

  

Microsoft® Windows® 8.x 
*1.3

  

CPU Over Intel® Pentium® 4  

2.8GHz  

Over Intel® Core™2 Duo 

E6400   

(Dual core processors are 

recommended.) 

Memory  Over 512MB Over 2GB 

Graphic Card  Over NVIDIA 

GeForce® 5900 /  

ATI™ RADEON™ 9800  

Over VRAM 64MB  

Over NVIDIA  

Quadro® FX 1300  

Over VRAM 256MB  

Display  XGA(1024×768)  

32bit color 

Over SXGA(1280×1024)  

32bit color 

 

(*1.3)32bits, 64 bits, System version (32bits latest Version is 3.3.0.0) 

  

 

 

 

 

1.4 Information Consultation and Support 
 

Telephone: +81-19-694-3103 (Direct Call) 

Mailbox: ve_support@i-plants.jp 

Web: http://www.i-plants.jp/hp 

 

mailto:ve_support@i-plants.jp
http://www.i-plants.jp/hp
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2.1 Functions that can be performed by VE 
VE focuses primarily on processing medical image data, and offers the following set of 

functions. 

 

 Inputting DICOM images, such as medical images,  

 Displaying multiple 3D images and constructing 3D images 

 Extracting portions of 3D images (segmentation) 

 Measuring 3D images 

 Reconstructing and manipulating 3D images 

 Outputting 3D image data and 3D shape data 
 

In addition, these functions have been designed according to VR’s human interface design, 

thus making conversational operation possible. 

 

2.1.1 Inputting medical images 
MRI and CT medical images can be input as the general DICOM image format. 

*2.1.1
 Besides 

it, the original image in RAW formats can also be input. 

 

*2.1.1 DICOM Image Format 

DICOM is an abbreviation of "Digital Imaging and COmmunications in Medicine" 

and is becoming a main standard for medical image format. Different from image 

formats used by computers, DICOM can display data of different shades of color on 

monitors. For more details about file input, refer to [4.1 Data Input and Output]. 

 

For more details about File Input/Output, refer to [4.1 Data Input and Output]. 
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2.1.2 Constructing 3D images 
Constructing 3D image from multiple 2D images. (Figure 2.1.1) 

(The 3D images are referred to as "volumetric images" or "3D volumetric images") 

VE can perform high-speed display of 3D images by utilizing Graphic Processing Units 

(GPUs) for the volume rendering. 

 

 
 

For more details about 3D image construction, refer to [4.9 Volume Rendering]. 
 

 

2.1.3 Extracting regions (segmentation) 
VE supports the following methods for the extraction of regions (segmentation): "Interactive 

segmentation", "Region Growing", and "Histogram base". 

Reconstructing 3D model from extracted images has greatly increased the possibility of 

flexible date processing. 
 

VE supports the following methods for the extraction of regions (segmentation): "Interactive 

segmentation", "Region Growing", and "Histogram base". 

Reconstructing 3D model from extracted images has greatly increased the possibility of 

flexible date processing. 

 
 

 

 

 

 

Figure 2.1.1 Construction of 3D images and shapes 

3D image Multiple 2D cross-sectional MRI images 

Figure 2.1.2 Segmentation with VE 
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2.1.4 Measuring 3D images 
VE supports measurements of lengths, angles, areas, and volumes in 3D images through 

interactive dialogue box. (Fig 2.1.3) 

 

 
 

 

2.1.5 3D Shape Model Reconstruction and Manipulation 
3D shapes can be reconstructed on the basis of 3D image data. (Fig 2.1.4) 

In addition, the generated 3D shape can also be edited by " Gap Repairing"," Pasting", 

"Surface Repairing" and etc. (Fig 2.1.5) 

 

 
 

 

Figure 2.1.3 Measurements performed on a 3D image 

Figure 2.1.4 3D Shape Model Reconstruction Figure 2.1.5 3D Shape Model Editing 
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2.1.6 Inputting 3D Image Data and Shape Data 
It is possible to output 3D images and 3D shape models prepared with VE into files. 

Furthermore, output to the DICOM image format, as well as the STL, DXF, VRML and 

other shape model formats is also supported. 
 

 
 

Volume Extractor 3.0 

Shape data / 3D image 

3D shape reconstruction 

Generation of iso-surfaces, data 

editing, data deletion 

Image display 

Display of iso-surfaces and 

cross-sectional layers, volume 

rendering 

Segmentation 

Editing of cross-sections, 

area expansion methods 

Image processing 

Noise removal, smoothing, 

clipping 

 

DICOM / original 

image (2D, 3D image 

data) 

Figure 2.1.6 VE’s Main functions and Composition 
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2.2 VE Application Examples 
3D Shape Models generated by VE can be effectively applied to a variety of medical 

situations, for example，reconstructing shape models of internal organs, blood vessels and 

the like, technical support before operation, operation simulation, medical education, 

medical treatment, situation analysis and simulation and so on. In addition, VE also makes it 

possible to make solid models by means of optical modeling apparatus and 3D printers. (As 

shown in Figure 2.2.1, Figure 2.2.2, Figure 2.2.3) 

 

 
 

 
 

 

Figure 2.2.1 Prototype Design by Optical Modeling Apparatus  

※Cooperated with Iwate Industrial Research Institute 

Figure 2.2.2 A sample of the brain mode created with a 3D printer 

Figure 2.2.3 Prototype Design by 3D Printer (Knee Model and Pottery Model) 



Volume Extractor Version 3.0 Operation Manual 15 

 

 

 

 

 

 

 

 

Chapter 3 

VE Screen Layout 



Volume Extractor Version 3.0 Operation Manual 16 

3.1 Screen Layout 
The screen layout of Volume Extractor is outlined as follows. 

 

3.1.1 Starting Screen Layout 

 
 

No. Items Reference Sections 

① Main Menu 3.2 Menu Structure 

② Tool Bar  3.1.2 Toolbar 

③ Slice View  4.18 SliceView 

 

3.1.2 Toolbar 

 
 

Icon Functions Reference Sections 

 
Volume Data Reading 4.1 Data Input and Output 

 
Volume Data Saving 4.1 Data Input and Output 

 
Clipping 4.2 Clipping 

 
Region Growing 4.3 Area Expansion 

 
3D Voxel Paint 4.5 3D Rectangle Painting 

 
Iso-Surface Generation 4.12 Iso-Surface 

 
Volume Rendering  

 

4.10 Volume Rendering 

 
Point-Based Volume 

Rendering 

4.11 Point-Based Volume Rendering 

① 

② ③ 

Figure 3.1.1 Starting Screen Layout 

Figure3.1.2 Toolbar 
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Icon Functions Reference Sections 

 
Index Image  4.13 Index Image 

 
3D Cross-Section  4.14 3D Cross-Section 

 
Camera  4.15 Camera 

 
Preference   6.1 Application Preferences 

 
Histogram 4.17 Histogram 

 
Measuring 4.21 Measuring Function 

 
Screen Capture 4.23 Screen Capture 
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3.2 Menu Structure 
The menu structure of Volume Extractor is outlined as follows. 

 

3.2.1 File 
It includes data input, data output and exit. 
 

 
 

 
 

 

No. Items Reference Sections 

① Data Input 4.1 Data Input and Output 

② Exit 

(Terminate VE application) 

 

③ Data Output 4.1 Data Input and Output 

 

Figure 3.2.1 File Menu (1) 

① 

② 

Figure 3.2.2 File Menu (2) 

③ 



Volume Extractor Version 3.0 Operation Manual 19 

3.2.2 Edit  
It includes a menu for volume data editing. 

 
 

No. Items Reference Sections 

① 
 

Clipping  4.2 Clipping 

② Region Growing  4.3 Area Expansion 

③ Image Filter  4.4 3D Image Filter 

④ Voxel Paint  4.5 3D Rectangle Painting 

⑤ Iso-Volume 4.6 3D Image Linear Interpolation 

⑥ Volume Carving 4.7 Dimensional Primitive (sphere, 

cylinder and rectangle) Carving  

⑦ Volume Segment 4.8 Any shape (two-dimensional) 

Delete 

⑧ Reverse X  4.9 Slice Direction Reversion 

⑨ Reverse Y  4.9 Slice Direction Reversion 

⑩ Reverse Z  4.9 Slice Direction Reversion 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

Figure 3.2.3 Edit Menu 
 

⑧ 

⑨ 

⑩ 
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3.2.3 Tools  
The following items are included in the tool menu: Volume Rendering, Iso-surface 

Generation, Mesh Editing, Camera Setting, File Information Skimming, Preference and so 

on.  

  

 
 

 

No.  Items Reference Sections 

① Volume Rendering  4.10 Volume Rendering 

② Iso-Surface 4.12 Iso-Surface 

③ Point-Based  

Volume Rendering  

4.11 Point-Based Volume Rendering 

④ Index Image 4.13 Index Image 

⑤ Cross Sections 4.14 3D Cross Section 

⑥ Camera  4.15 Camera 

⑦ Rebuild  

(Reconstructing DICOM Data 

Base)  

 

⑧ File Information  4.16 File Information 

⑨ Preference 6.1 Application Preferences 

 

⑧ 

⑦ 

⑥ 

⑤ 

④ 

③ 

② 

① 

⑨ 

Fig 3.2.4 Tool Menu 
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3.2.4 Mesh Editing  
Meshing data can be displayed in active WorkForm.  

Refer to [Meshing Editing] in Chapter 5. 

 

 
 

 

 

Figure 3.2.5 Mesh Editing Menu 
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3.2.5 Window 
It has two switchable windows: Special Menu Displaying Window and The Currently Active 

Window. 

 
 

No. Items Reference Sections 

① Histogram  4.17 Histogram 

② Slice View  4.18 Slice View 

③ DICOM Manager  

( DICOM 

Management Tool)  

4.20 DICOM Manager 

④ Measure Manager  

 

4.21 Measuring Function 

⑤ Window W/L  4.22 Window W/L 

⑥ Slice View Fix to 

Upper Right 

 

⑦ Active Window 

Switching 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

Figure 3.2.6 Window Menu 

⑦ 
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3.2.6 Help 
VE Version and Mouse Guide Information Menu 

 
 

 

No.  Item Description 

① About Volume 

Extractor  

Display VE Version Information Window  

② Mouse Operation 

Guide 

Show how to operate the mouse on the work form 

 
 ○Display example of mouse operation guide 

 
 

Figure 3.2.7 Help Menu 
 

① 

② 
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3.3 WorkForm 
WorkForm displays data reading. Refer to [Mesh Editing] in Chapter 5. 

 

3.3.1 Function Outline 
WorkForm has the following main functions: Volume Data 3D Display, Volume Data 

Cross-Section Display, Volume Data Display. 

 

3.3.2 Screen Description   
 

 
 

 

 

② 

④ 

③ 

⑤ 

⑥ 

⑦ 

⑧ 

⑫ 

⑪ 

⑩ 

⑨ 

① 

Figure 3.3.1 WorkForm of Division Model 
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No.  Items Descriptions 

① Title Bar  Display file names 

② XY Cross Section Display volume data of XY cross section 

③ YZ Cross Section Display volume data of YZ cross section 

④ XZ Cross Section Display volume data of XZ cross section 

⑬ 

⑭ 

⑮ 

⑯ ⑰ ⑱ 

Figure 3.3.2 Cross Section Display of WorkForm 

⑲ 

⑳ 

Figure 3.3.3 3D Display of WorkForm 
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No.  Items Descriptions 

⑤ 3D Display Display 3D image 

⑥ State Bar   Display mesh editing function, measurement model, 

if volume data exists or not, if polygon data exists or 

not 

⑦ 3D Switch Display   Display switch between 3D Display and No 

Displaying 

⑧ Volume Data Switch Display Display switch between Volume Data Display and 

No Displaying 

⑨ 3D Cross Section Display  Display switch between 3D Cross Section Display 

and No Displaying 

⑩ WorkForm Model Switch 

Display 

Display WorkForm Model Switch. Refer to 

WorkForm Model Switch Display in 3.3.3 Operation 

Manual 

⑪ Clipping Plane Switch Display Switch from clipping plane display to Non display 

on 3D crossed section. For detailed information, 

refer to Regular Clipping Display Switch in 3.3.3 

Operation Guide 

⑫ Information Switch Display Switch between Display and Non Display of position 

on the cross section and light value WindowW/L 

value (WW/WC) 

(The number inside the bracket of light value refers 

to the previous scale number in 
*3.3.1

 

If WindowW/L is invalid, WW/ WC will not display.  

For more information, see WindowW/L in Chapter 4 

[Function Descriptions] 

⑬ Cross Section Display  Display Cross Section Image 

⑭ Horizontal Scrolling Move the cross-section image horizontally 

⑮ Vertical Scrolling Move the cross-section image vertically 

⑯ Size Changing Button   Display the size of the changed cross-section image 

⑰ Slice Position Track Bar  Change the slice position of displayed cross section 

⑱ Move the slice position up and 

down 

Change the slice position of cross section 

⑲ Three Dimension Display Display Volume data or triangle face 

⑳ Guide Positions of 3D Display 

A : Anterior 

P : Posterior 

H : Head 

F : Feet 

R : Right 

L : Left 

 

 

 

 

 

*3.3.1 Rescaling 

Display height correction value according to the information of  

“Rescaling Tilt” “Rescaling Slice” included in DICOM images. 
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3.3.3 Operation Guide 

○ Polygon Display Switch 

If you click the icon, switch display appears. 

 

Icon Functions Descriptions 

 
Vertex  Switch between Vertex Display and  

No Displaying 

 
Edge  Switch between Edge Display and  

No Displaying 

 
Flat Face  Display 3D Shapes in Flat Face 

 
Smooth Face  Display polygon shapes in smooth face 

 
Normal  Switch between Normal Display and 

No Displaying 

 
Open Edge  Switch between Open Edge Display and  

No Displaying 

 

○Volume Display Switch 

Click the icon and switch display will appear. 

With regard to color table change, refer to [Volume Rendering] and [Index Image] of  

[Function Descriptions] in Chapter 4. 

 

Icon Function Description 

 
Volume Switch between Volume Display and  

No Displaying 

 

○ 3D Cross Section Display Switch 

Click the icon and the switch gets started. 

With regard to changing the position of cross section, refer to [3D Cross Section] in  

[Function Descriptions] of Chapter 4. 

 

Icon Function Description 

 
Cross Sections  Switch between Display Cross Section and  

No Displaying 

 

○ WorkForm Display Switch 

Click the icon and the switch gets started. 

 

Icon Functions Descriptions 

 
Division  Display quartering WorkForm 

 
3D  Display 3D Image only 

 
XY  Display XY Cross Section only 

 
YZ  Display YZ Cross Section only 

 
XZ  Display XZ Cross Section only 
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○ Clipping Plane Display Switch 

Click the icon and the switch gets started.  

Icon Function Description 

 
Clipping Plane  Switch between Clipping Plane Display and  

No Displaying 

 

○ Information Display Switch 

Click the icon and the switch gets started.  

Icon Function Description 

 
WorkForm Info  Switch between Pos, Lv, WW/WC Display and 

No Displaying 

 

○ Cross section display operation 

 

-Display the position change of cross section. 

The position change can be done in horizontal and vertical scrolling. The cross section can 

also be dragged and shifted. 

 

- The size of cross section can be changed. 

The change is done by using the Size Change Button. 

 

-Change the position change of displayed slice 

The change is done by moving the slice position upwards and downwards. 

 

-Change Window W/L 

This is done by dragging the image in upper right direction. For more details, refer to 

[WindowW/L] in [Function Descriptions] of Chapter 4.  

 

○ Basic Operations of 3D Display 

-Rotate the volume and polygon. This is done by dragging 3D image. 

 

-Zoom in and Zoom out 

This is done by dragging the image to the right. The section is zoomed in if the mouse cursor 

is moved upwards while the section is zoom out if the mouse cursor is moved downwards  

 

-Move the camera leftwards and rightwards or upwards and downwards. 

This is done by pushing the button "Z" and dragging the image at the same time. 

 

○ Clipping Plane Operation 

- Rotate the clipping plane 

Press down Ctrl key and drag the 3D image at the same time, making it rotate around the 

original point. 

 

-Move the clipping plane 

Press down Ctrl key and at the same time drag the image to the right towards the direction of 

a normal. 

 

 

3.3.4 Preference 
Refer to WorkForm Initialization in section [Various Setting] of Chapter 6. 
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Chapter 4 

Function Descriptions 
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4.1 Data Input and Output 
    

Input 
From the menu list, select one of them： 

[Open],[Impore]->[Image]->[Files],[Import]->[Images][Directory],[Impore]->[Images]->[D

irectory],[Import]->[Images]->[3D Images],[Import]->[Polygon] or click Toolbar . 

 

Output 
From the menu list, select one of them：  

[Save],[Export]->[Images]->[Files],[Export]->[Images]->[Images]->[3D 

Images],[Export]->[Polygon] or click Toolbar . 

 

4.1.1 Function Outline 
 

○Input 

Read image data 

In the [Open], read the file content in VDF and VOL format. 

In the [Files], [Directory], read the file content in DICOM, RAW, BMP, JPEG and TIFF 

format. 

In the [3D Images], read the file content in Analiyze7.5 File, Visualization Toolkit File,  

CarlZeiss File, 3DView File and other 3D Image File format. 

In the [Polygon], read the file content in STL and PLY format. 

 

Please refer to the URL below for PLY format. 
http://www.cc.gatech.edu/projects/large_models/ply.html 
 

○Output 

In the [Save], save the file in VDF and VIF1/VOL and VOL compress format. VOL 

compress saves VOL with run length compression and can read like VIF / VOL file input. In 

particular, it can be expected that the capacity will be drastically reduced for binary images 

with small thresholds. 

In the [Images]-[Files], file saving is done in DICOM and RAW format. 

In [Images]-[3D Images], file saving is done in Analyze7.5 and FLD and 3DView format. 

In [Polygon], file saving is done in STL, MGF, DXF, VRML and SMF format. 

Notes: files saved in DICOM format cannot found in DICOM Management. 

 

http://www.cc.gatech.edu/projects/large_models/ply.html
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4.1.2 Screen Specification 
 

○ Input 

The following options are provided [Open], [Files], [3D Images], [Polygon]. 

 

 
 Figure 4.1.1 File Selection Options 

 

No. Items Descriptions 

①  File List Showing a list of all files 

②  File Type  Making selection by its extension name 

③  Open  Choose to open the file 

④  Cancel  Choose to close the file reading 

 

In [3D Images], it is possible to read a three-dimensional image of any format If you select 

[All Files] on the type of file. You are prompted to enter in the form of a three-dimensional 

image dialog box is displayed when you select a three-dimensional image file. 

 

① 

② 

③ ④ 
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No. Items Descriptions 

①  Skip Header Bytes Specify the number of bytes to skip if there is 

wasted space at the top of the image file 

②  Data Size Specify the number of voxels X, Y, and Z 

directions 

③  Pitch Specify the pitch X, Y, and Z directions. 

Value of Default Pitch preferences form is the 

initial value 

④  Data Type Specify the number of bytes in a single voxel, 

unsigned or signed data 

⑤  OK Read a three-dimensional image file based on 

the information you entered 

 

 

① 

② 

③ ④ 

⑤ 

Figure 4.1.2 Three-dimensional image format input form 
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 Form in 【Directory】 

 
 

No. Items Descriptions 

①  File List Showing a list of all files 

②  OK Open the chosen files 

③  Cancel Close the chosen files 

 

In [Directory], the file list will be displayed if the files are saved in the above formats. 

 

 
 

No. Items Descriptions 

1.  File List Showing a list of all files 

2.  Format Type Choice open files format 

3.  Open Open the chosen files 

4.  Cancel Close the chosen files 

 

Once the file is saved in DICOM format, the format will be displayed for DICOM 

information input. 

① 

② ③ ④ 

Figure 4.1.4 File Selection Form 

② ③ 

① 

Figure 4.1.3 File Selection Format 
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Raw file input when a form to enter the image information is displayed. 

 

 
 

No. Items Descriptions 

 ① Data size Designate the length and width of the image 

 ② Pitch  Designate the length and width and height 

pixels 

Value of Default Pitch preferences form is the 

initial value 

 ③ Data Type Designate the data type 

 ④ OK Read file by input data 

 ⑤ Cancel Stop file reading and close the window 

 

When the STL file is in input, the file will project a window screen.  

And then input image information.  

 

 
 

No. Items Descriptions 

 ① Polygon scale 

 

Designate the scale information of the image in 

length, width and height 

Value of Default Polygon Scale preferences 

form is the initial value 

 ② OK Read file by input data 

 ③ Cancel  Stop file reading and close the window 

① 

② 

③ 

④ ⑤ 

Figure 4.1.5 Raw Data Selection 

Form 

② ③ 

Figure 4.1.6 Scale Information Input Form 

① 



Volume Extractor Version 3.0 Operation Manual 35 

○ Output 
File output form 

 

 
 

No. Items Descriptions 

 ① File List  Display file list 

 ② File Type Minimize the file size by its suffix name and 

designate file saving format 

 ③ OK Output file in specified format 

 ④ Cancel  Stop file reading and close the window 

 

① 

② 
③ ④ 

Figure 4.1.7 File Saving Form 
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If preservation is performed as a DICOM file, the form for inputting DICOM information 

will be displayed. 

 

 
Figure 4.1.8 DICOM Information Input Form 

 

No. Items Descriptions 

 ① Modality  Input modality information 

 ② Row  Input row data 

 ③ Column  Input column data 

 ④ Slice Thickness  Input slice-thickness of DICOM 

 ⑤ Spacing Between Slice  Input spacing between slices 

 ⑥ Pixel Spacing(X)  Input pixel spacing (X) 

 ⑦ Pixel Spacing(Y)  Input pixel spacing(Y) 

 ⑧ Pixel Padding  Input pixel padding 

 ⑨ Samples per Pixel  Input samples per pixel 

 ⑩ Photometric Interpretation  Indicate if there is brightness rotation 

 ⑪ Data Type  Select data type 

⑫ Windows Level  Input winder level 

⑬ Windows Width  Input window width 

 ⑭ Rescale Intercept  Input rescaled intercept 

⑮ Rescale Slope Input rescaled slope 

 ⑯ Save  Save the input data 

 ⑰ Cancel  Close the file and stop saving 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑫ 

⑬ 

⑭ 

⑮ 
⑯ ⑰ 

⑩ 

⑪ 
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4.2 Clipping 

In [Edit] menu, select [Clipping]. And then clip Toolbar . 

 

4.2.1 Function Outline 
Take away a certain part of volume data. 

 

○ Result Handled Case 

Take away one part of a head and visualize it through volume rendering and the result is 

clearly indicated. 

 

 
 

 

Figure 4.2.1 Clipping Case 
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4.2.2 Screen Description 

 
 

 

No. Items Descriptions 

① X axis Track Bar Indicate the clipping range of X axis 

② The minimum value of  

X axis Clipping  

Indicate the minimum value of X axis clipping 

③ The maximum value of  

X axis Clipping  

Indicate the maximum value of X axis clipping 

④ Y axis Track Bar Indicate the clipping range of Y axis 

⑤ The minimum value of 

Y axis Clipping  

Indicate the minimum value of Y axis clipping 

⑥ The maximum value of  

Y axis Clipping  

Indicate the maximum value of Y axis clipping 

⑦ Z axis Track Bar Indicate the clipping range of Z axis 

⑧ The minimum value of  

Z axis Clipping  

Indicate the minimum value of Z axis clipping 

⑨ The maximum value of  

Z axis Clipping  

Indicate the maximum value of Z axis clipping 

⑩ Move to Center  A sign that indicates moving the object to the center after 

clipping 

⑪ Undo Return to one previous state 

⑫ Execute  Execute voxel clipping 

 

Figure 4.2.2 Clipping Form 

 

① ② 

③ 

④ ⑤ 

⑥ 

⑦ ⑧ 

⑨ 

⑩

」 ⑪ ⑫ 
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When displaying clipping form, use red color line to indicate the range of clipping in 

WorkForm.  

 
 

 

4.2.3 Operation Guide 
 

○ Decide the clipping range of X, Y, Z axis 

In one of the following ways, I can select the clip range. 

・Move the knob of X, Y, and Z-axis track bar 

・Enter a number in the text box 

・Click up and down in the box (up and down arrow) 

 

○ Press [Execute] key 

1. Do clipping 

2. When checking [Move to Center], move the object to the center after clipping 

 

○Return to one previous state 

After executing the fill process, the [Undo] button is enabled. 

If you press the [Undo] button, you can return to the previous state. 

 

 

Figure 4.2.3 Clipping Range Display 

*4.2.1 About Undo Button 

Clipping processing undo function becomes invalid when clipping form is 

closed and it cannot return to the state just before processing. 

Please note that this form will be closed automatically even if you switch 

WorkForm. 
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4.3 Area Expansion 

From [Edit] menu list, select [Region Growing] or Click Tool bar.  

 

4.3.1 Function Outline 
This part is to do an area expansion. A choice can be made between 2D area expansion  

and 3D area expansion. The SEED point can be chosen multiple times. 

 

4.3.2 Display Description 
 

○ Description of Each Control 

 
 

 

No. Items Descriptions 

①  Screen  Display the image to be handled 

②  Minimizing Key Minimize the image area selected in ① 

③  Enlarging Key Enlarge the image area selected in ① 

④  Use Slice Number to indicate the 

sliced bar 
Slice the specified area in ① 

⑤  Slice Number  Indicate the number of sliced area 

⑥  Fit to Screen If the check is On, to view the entire image on the 

screen 

⑦  Handling Method Indicate how to handle the image (2D, 3D) 

⑧  Seed List Display SEED List 

⑨  Delete Remove the selected points in the SEED List 

⑩  Delete All Remove all the stuff in SEED 

⑪  Interactive G/L Settings 

(Auto and Manual  Setting of 

Global and Local Parameters) 

Switch between auto and manual of global and local 

parameters 

⑫  General Parameters of Sliding 

Bar 

Designate general parameters 

Figure 4.3.1 Control Description of Area Expansion File 

 

① 

② ③ ④ ⑤ 

⑦ ⑧ 

⑨ ⑩ 

⑪ 
⑫ 

⑬ 

⑭ 
⑮ 

⑱ 
⑲ 

⑳ 

⑥ 

㉓ ㉔ 

㉖ 

⑯ ⑰ 

㉒ ㉑ 

㉗ ㉕ 
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No. Items Descriptions 

⑬  Local Parameters of Sliding Bar Designate local parameters 

⑭  Restricted region Add the function of region restriction by using 

2D-Multi 

⑮  Limits to Z-Axis Designate the sliced section by using 2D-Multi 

⑯  Sliding Bar for deciding the 

range of sliced section 

Designate the range of sliced section by using 

2D-Multi 

⑰  The maximum range of the 

sliced section 

Designate the maximum range of sliced section by 

using 2D-Multi 

⑱  The minimum range of the sliced 

section 

Designate the minimum range of sliced section by 

using 2D-Multi 

⑲  Execute Implement Area Expansion 

⑳  Reset Implement deletion 

㉑ Inside Select Choose You may need to do “Inside” the extended 

area fill 

Not Change: not performed 

Select Value: Do fill 

㉒ Inside Paint Parameter When Inside is Select Value, to specify the value of 

the fill. The initial value is the maximum value of the 

slice 

㉓ Outside Select Choose You may need to do “Outside” the expansion 

area fill 

Not Change: not performed 

Select Value: Do fill 

㉔ Outside Paint Parameter When Outside is Select Value, to specify the value of 

the fill. The initial value is the minimum value of the 

slice 

㉕ Window W/L Toggle enable / disable of window level setting for 

slice image 

㉖ OK Accept the data and close the form 

㉗ Cancel Cancel the result and close the form 
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4.3.3 Operation Guide 

 
○ Change the screen size 

Use the control button described in ② and ③ to designate the size. 

If the size to be designated goes beyond what is described in ①, it should be demonstrated 

in the scroll bar. 

     

○ Fit to Screen 

Input Check in control description ⑥. 

 

○ Change the sliced section 

Move the sliding bar in Control Description ④. The left side is ① and the right side is the 

maximum number for slicing. Or input number into Control Description ⑤. 

 

○ Add SEED 

Inside ①, click the place that SEED wants to fix. 

Use number ⑧ to indicate the addition of SEED. 

When executing area expansion, use the list in ⑧. 

From the unhandled place, delete check box in ⑧. 

 

○ Decide handling approach 

Specification can be done in Control Description in ⑦, which has 2D, 2D-Multi, and 3D.  

In 2D-Multi, the check box in ⑭ and ⑮ of control description is valid. 

 

○ Use the specified scope (only for 2D-Multi) 

Input Check in control description ⑭ and execute region growing in the specified scope. 

 

○ Specify global and local parameter 

Input Check in control description ⑪. 

The operation described in control description ⑫, ⑬ becomes possible.  

Specify the number by moving the scroll bar. 

If the check button does not exist in control description ⑪, the number can be automatically 

set. 

 

○ Decide Z scope (only for 2D-Multi) 

Insert Check into control description ⑯. 

The operation described in control description ⑯, ⑰, ⑱ becomes possible. 

Specify the scope by moving the scroll bar. 

If the Check button does not exist, all the slices are to be done. 

 

○ Region Growing  

Click Button Description in ①.  
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○After determining the area, I will extract only in the extended area (Inside) 

1. Running the region growing method in advance button ⑲ 
2. Select “Not Change” in Inside Combo box 

3. Select “Select Value” in Outside Combo box (In this case, number of Outside the 

minimum value of the pixel has been entered) 

4. Press button ㉕, "and then exit to update the data. Are you sure you want?" Because the 

message is displayed, and then select the "Yes". Thus, three-dimensional image data is 

updated, only Inside is extracted 

 

○After determining the area, I do binarization in the extended area (Inside) and extended outside 

the region (Outside) 

1. Running the region growing method in advance button ⑲ 

2. Select “Select Value” in Inside Combo box (In this case, number of Inside the maximum 

value of the pixel has been entered) 

3. Select “Select Value” in Outside Combo box (In this case, number of Outside the 

minimum value of the pixel has been entered) 

4. Press button ㉕, "and then exit to update the data. Are you sure you want?" Because the 

message is displayed, and then select the "Yes". As a result, the three-dimensional 

image data is updated, it is binarized 

 

○After determining the area, I do fill only extended outside the region (Outside) 

1. Running the region growing method in advance button ⑲ 

2. Select “Select Value” in Inside Combo box, more to change the right of the numeric 

value to the same value as the Outside of the numerical 

3. Select “Not Change” in Outside Combo box 

4. Press the button ㉕, "and then exit to update the data. Are you sure you want?" Because 

the message is displayed, and then select the "Yes". As a result, the three-dimensional 

image data is updated, only Outside is filled with black (it is the same result as the 

Inside only extraction) 

 

 
  

 

4.3.4 Setting 
Refer to [Area Expansion] in Chapter 6 [Application Preferences]. 

 

Figure 4.3.3 Result Handled Case 
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4.4 3D Image Filter 
3D image filter cannot be used in WorkForm that does not contain volume data. 

Select [Image Filter] in [Edit] menu. 

 

4.4.1 Function Outline 
Volume data can perform the following functions: 

・Smoothly delete simple low noise 

・Make binary image 

・Switch between bright and dark color 

・Edge Extraction 

・Dilation or Erosion image 

・Distance Transformation to binary image 

・Gradient Filtering 

・Standard Deviation Filtering 

・Handle the filter defined by the user 

※Dilation/Erosion supports gray scale image and binary image. Distance Transformation 

supports binary image 

 

○ Handled Case Description 

The picture before handling (as shown in figure 4.4.1) and the picture after the shade of 

color are changed. (As shown in figure 4.4.2) 

 

Figure 4.4.1 Before Reversing 

Figure 4.4.2 After Reversing 
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4.4.2 Screen Description 
 

 
*4.4.1 Screen Structure of Image Filter Form 

Image Filter Form is used to filter the selected screen and change 

the indicated controller. Example, as ⑤～⑦ of Figure 4.4.3, this 

form is represented only when [Binaries] or [Dilation/Erosion] is 

selected. 

 

 
 

Figure 4.4.4 Image Filter Form (Smoothing) 

⑳ 

Figure 4.4.3 Image Filter Form
*4.4.1

 
 

①①①    

③ ④ 

⑤ 

⑥ 
⑦ 

⑧ 

⑨ 

⑪ 

⑮ 

⑫ 

⑯ 

⑲ 

② 

⑩ 

⑰ ⑱

ゅ

う

ろ

く 

⑬ ⑭ 
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Figure 4.4.6 Image Filter Form (Dilation or Erosion) 
 

㉒ 

㉓ 

 

膨張 収縮 

Figure 4.4.5 Image Filter Form (Edge Extraction) 
 

㉑ 
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No. Items Descriptions 

① Cross section Display Display the crossed section 

② Image Size Adjustment Adjust the magnification of the screen in ① 

③ Sliced Position  

Track Bar 

Designate the sliced position of the cross section 

 

④ Sliced Position  

Numerical Box 

Designate the sliced position of the cross section 

⑤ Select Filter  Select screen handling filter 

⑥ Preview Check Box Prepare to use ① to confirm the binarized result 

⑦ Threshold’s up down   Designate the binarized threshold 

⑧ Threshold’s Track Bar Designate the binarized threshold 

⑨ Min Value 

Track Bar 

Designate the binarized min value (black value) 

⑩ Min Value 

Numerical Box 

Designate the binarized min value (black value) 

⑪ Max Value 

Track Bar 

Designate the binarized max value (white value) 

⑫ Max Value 

Numerical Box 

Designate the binarized max value (white value) 

Figure 4.4.8 Image Filter Form (Standard Deviation) 
 

㉕ 

Figure 4.4.7 Image Filter Form (Gradient) 
 

㉔ 
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No. Items Descriptions 

⑬ Apply Button  Use filter to handle the selected screen 

⑭ Reset Button Restore to the first preview image 

⑮ Select Plane Type  Select the displayed plane from XY,YZ,XZ 

⑯ Preview Window W/L 

Mode Check Box  

Make valid the screen set by Window W/L in WorkForm 

⑰ OK Button  It is used to handle the data in Window W/L 

Close Image Filter form 

⑱ Cancel Button  Cancel the handled image and close Image Filter form 

⑲ X button  Cancel the handled image and close Image Filter form 

⑳ Neighbor Type Select the vicinity type and the range of time of scanning 

the image. 

You can choose Neighbor Type [Rectangle] or [Sphere] 

radio button. You can also choose Neighbor Range 

[Voxels] (Pixel size) or [Length] (Real size). 

For more information, please refer to "4.4.3 Operation 

Guide" 

㉑ Sobel / Laplacian  Select edge sampling filter type 

㉒ Dilation / Erosion 

Radio Button 

Select dilation or erosion filter type 

㉓ Iteration Num Select dilation or erosion filter iteration times 

㉔ Gradient Determine slope (difference in density) between pixels to 

extract only pixels to be above a specified threshold value 

㉕ Standard Deviation Standard Deviation in the vicinity specified by the 

Neighbor Type for each pixel to extract only pixels to be 

above a specified threshold value 
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4.4.3 Operation Guide 

 
○ Execute Simple Noise Deletion 

1. Select [Simple Noise Deletion] filter 

2. Click Apply Button 

 

○ Execute Smoothing 

1. Select [Smoothing] filter 

2. Click Apply button 

 

○ Execute Binarize 

1. Use the filter to select [Binarize] 

2. Use the threshold track bar and threshold up down to designate threshold 

3. Click Apply button 

 

○ Execute Distance Transformation
*4.4.2

 

1. Use [Binarize] filter and surface to be extracted  

2. Select [Distance Transformation] filter 

3. Click Apply button 

 

*4.4.2 About [Distance Transformation] Image Filter 

On the binary image, it is a filter that performs a three-dimensional 

Euclidean distance transformation. Against the background of a 

black image, it will represent the shortest path to reach the white at a 

concentration of 0-255. It will be whiter closer to 255. 

For example, a blood vessel (coronary artery, hepatic vein, etc.) to 

the CT image, which put the contrast agent to, it is can be applied, 

such as finding the shortest route to the vessel arrival. 

 

 
○ Carry out color shade reversing 

1. Use the filter to select [Reversing B/W] 

2. Click Apply button 

 

○ Carry out edge sampling 

1. Use the filter to select [Edge Extraction] 

2. Select Sobel or Laplacian 

3. Click Apply button 

 

○ Carry out dilation or erosion 

1. Use the filter to select [Dilation/Erosion] 

2. Select Dilation or Erosion filter type and Input the loop count. 

3. Click Apply button 

Figure 4.4.9 Example of Distance Transformation 
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○ Change the screen size 

Click minus (-) button and the image will become smaller. 

Click plus (+) button and the image will be enlarged. 

 

○ Change cross section 

Click any of the three choices [XY] [YZ] [XZ] if the section is to be crossed. 

When changing the sliced position, move the sliced position track bar or move the sliced bar 

up and down. 

 

○ Change Neighbor Type (Only - Dilation or Erosion filter, Standard Deviation filter) 

1. From ⑲ Neighbor Type, Select [Rectangle] or [Sphere] 

2. Select [Voxels] or [Length], you can specify a range in the vicinity. In the case of Voxels, 

it can be one from the right of the combo box of [3 × 3 × 3] or [5 × 5 × 5] or [7 × 7 × 7]. 

For Length, you can specify a [1-10] 

3. Click Apply Button 

 

○Terminating screen operation 

1. Click OK button if they handled screen applies to WorkForm 

2. Click × button or Cancel button if they handled screen does not apply to WorkForm. 

 

 *4.4.3 About [Gradient] and [Standard Deviation] Image Filter 
Both gradient and standard deviation are effective for edge detection. 

The gradient extracts only pixels with large variation from the difference between the 

pixel of interest and the adjacent pixel. The calculation formula of the threshold when 

the number of pixels n and the difference in each axis direction is fx, fy, fz is shown. 

 
For standard deviation, we extract only pixels with large standard deviation from 

neighboring pixels of the target pixel. The calculation formula of the threshold when 

the number of pixels n and arithmetic mean μ is shown. 

 



Volume Extractor Version 3.0 Operation Manual 51 

4.5 3D Rectangle Painting 

In [Edit] menu, select [Voxel Paint] or click Toolbar.  

 

 

4.5.1 Function outline 
It will specify the area to be painted on 3D space. The painting is done according to the 

specified brightness by confirming the data content. 

 

 
 

 

Figure 4.5.1 Function of Fully painted 3D Rectangle Cube 
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4.5.2 Screen Description 

 
○Control Form  

 

 
 

No. Items Descriptions 

①  X Track Bar It specifies the painting area in X bar direction 

(to the minimum or to the maximum) 

②  The minimum  

value of X Bar 

It specifies the minimum value of painted area in X bar 

direction in number 

③   The maximum  

value of X Bar 

It specifies the maximum value of painted area in X bar 

direction in number 

④  Y Track Bar  It specifies the painting area in Y bar direction 

(to the minimum or to the maximum) 

⑤    The minimum  

value of Y Bar 

It specifies the minimum value of painted area in Y bar 

direction in number 

⑥  The maximum  

value of Y Bar 

It specifies the maximum value of painted area in Y bar 

direction in number 

⑦  Z Track Bar  It specifies the painting area in Z bar direction. 

(to the minimum or to the maximum) 

⑧  The minimum  

value of Z Bar 

It specifies the minimum value of painted area in Z bar 

direction in number 

⑨  The maximum  

value of Z Bar 

It specifies the maximum value of painted area in Z bar 

direction in number 

⑩  Coloring Brightness 

Specification 

The coloring brightness is specified in number 

 

⑪ Coloring Brightness 

Shade Difference  

It can indicate the shade difference in painting 

⑫ Coloring Brightness  

Selection 

(Track Bar) 

Use the track bar to select the painting brightness 

⑬ Preview 

(Preview Check Box) 

Switch for displaying the previewed content in the specified 

area 

Figure 4.5.2 Operating Form of 3D Rectangle Cube Painting 

① ② 

③ 

④ ⑤ 

⑥ 

⑦ ⑧ 

⑨ 

⑩ 

⑪ 

⑫ 

⑬ 
⑭ 
⑮ 

⑯ 

⑰ 
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No. Items Descriptions 

⑭ Opacity of 2D Tex 

(Track bar for 

specifying opacity of 

2D Tex) 

Specify the opacity of 2D Tex the needed by the designated 

rectangle area 

⑮ View inner Volume 

Check Box for volume 

view switch  

Switch to show if there is display of volume screen in the 

specified area or not 

⑯ Undo 

(Undo Button) 

Returns the executed process to the previous state 

⑰ Execute 

(Execute Button) 

Implement the painting task 
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4.5.3 Operation Guide 
 

○ Specifying painting areas 

To specify the painting areas, select X, Y, Z track bars in ①-⑨, or change the number 

indicating slice position. 

 

○ Displaying preview screen 

This can be done by check the Preview Check Box in ⑬ Previewing can be done in 2D Tex 

and 3D volume. 

2D Tex can be displayed on selected rectangle shape by using opacity track bar in ⑭ to 

adjust its projecting level.
*4.5.1

 

3D volume indicates the volume within the rectangle space by clicking the checking box for 

volume switch ⑮ which indicates On or Off.
*4.5.2

 

 

*4.5.1 2D Tex Display Specification 

2D Tex is not only opacity specification, but also demonstrates the 

specified content in Window W/L. (As shown in Figure 4.5.3) 

 

    

 
 

*4.5.2 Preview on-display volume screen  
Previewing on-display 3D volume screen is executed by means of 

specified rendering. (Volume Rendering, Point Base Volume 

Rendering and Index Image) 

 

○ Preview volume screen only  

When volume screen is to be previewed only, move the track bar of 2D Tex opacity  

to the left, making 2D Tex become transparent and 3D volume display possible. 
*4.5.3 *4.5.4

 

   

*4.5.3 This function cannot be co-used with Clipping Plane.  

Once 3D volume screen is previewed, the two functions cannot be 

co-used. Once co-used, the volume screen within rectangle cannot 

be displayed. (As shown in Figure 4.5.4) 

 

Figure 4.5.3 2D Texture display specified according to Window W/L 
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*4.5.4 Image overlapping may occur at the usual rendering function. 

When displaying rectangle volume, it is possible to display usual volume 

rendering. 

If rectangle volume is displayed only, perform this by volume display 

switch on WorkForm. 

 

○ Perform painting 

1. Input number in ⑩ of Control Form or use the brightness number in ⑫ track.
*4.5.5

 

2. Press [Execute] button in ⑰ and carry out painting. 
*4.5.6

 

 

*4.5.5 Movement of Window W/L and Specified Painting Color  

Brightness number indicated in ⑪ and gradation indicated in ⑫ can be 

moved together at Window W/L.(As shown in Figure 4.5.5) 

 

 
 

*4.5.6 Use the color brightness to express volume 

After painting with maximum and minimum brightness, volume screen can 

be previewed with a variety of brightness inside the rectangle. At this time, 

the preview is performed at specification of default transfer function of 

volume rendering. (As shown in Figure 4.5.6) 

 

Figure 4.5.5 Color Change of Painting Specification by Window W/L 

Figure 4.5.4 The change caused by using by Clipping Plane 
Normal Clipping 
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○ Restore the part being processed to its former state. 

[Undo] button becomes valid after painting is processed. 

Once [Undo] button is clicked, the previous state is restored. 
*4.5.7

 

 

*4.5.7 About canceling function 

When terminating 3D rectangle painting process, close off 3D Voxel Paint 

Form and, thus making painting invalid and unable to return to its former 

state. Remember that this form can be automatically closed down when 

switched to Word Form. 

 

Figure 4.5.6 Painting Processed Case 

Executing Painting at Minimum Brightness 

Executing Painting at Maximum Brightness 
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4.6 3D Image Linear Interpolation  

Select [Iso-Volume] in [Edit] menu. 

 

4.6.1 Function outline  
Through this function, line insertion can be made onto 3D image. The executed image will 

have the same voxel size with X, Y, Z and the same the volume. 

 

 

4.6.2 Screen Description  
 

○ Control Form 

 

  
Figure 4.6.2.1 Line Insertion Diagram Screen  

 

No. Items Descriptions 

① Indicate the current 

Voxel number 

Display the current Voxel number of X, Y, Z direction of 3D image 

② Indicate Result 

Voxel Number 

Display the Voxel number of X, Y, Z direction of 3D image after 

insertion 

③ X Rate Specify the Voxel number of X direction at the rate of current 

voxel number 

④ Y Rate Specify the Voxel number of Y direction at the rate of current 

voxel number 

⑤ Z Rate  Specify the Voxel number of Z direction at the rate of current 

voxel number 

⑥ Equant Button The magnification used as an equant voxel is set up automatically 

⑦ Execute Button  Execute the Linear Interpolation 

  

 

① 

② 

③ 

④ 

⑤ ⑥ 

⑦ 
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4.6.3 Operation Guide 
 

○ Specify Rate 

Specify the number of ③, ④, ⑤, by clicking addition or subtraction button on the right.  

Input by means of keyboard. 

 

※⑥ If it clicks a equant voxel button, the magnification at the time of forming the method 

voxel can be calculated automatically. 

 

○ Insertion 

Click ⑦ and insertion is performed. 
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4.7 Dimensional Primitive 

(sphere, cylinder and rectangle) Carving 
 

From [Edit] menu, select [Volume Carving]. 

 

 

4.7.1 Function Outline 
On 3D screen, specify the domain to be carved. Carve the specified place only. (Mode: 

inside). Carve the area beyond the specified domain. (Mode: outside). 

 

 
 

 

Figure 4.7.1.1 Cylinder Carving (Inside) Figure 4.7.1.2 Cylinder Carving (Outside) 
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4.7.2 Screen Description  
    

○ Control Form 

  

 
 

Figure 4.7.2.1 Extraction Specification Control Form  

 

No. Items Descriptions 

① Carving X width Specify the size of carving in X direction 

② Carving Y width Specify the size of carving in Y direction 

③ Carving Z width Specify the size of carving in Z direction 

④ Carving X angle Specify X angle of carving shape 

⑤ Carving Y angle Specify Y angle of carving shape 

⑥ Carving Z angle Specify Z angle of carving shape 

⑦ Carving X position Specify carving position in X direction 

⑧ Carving Y position Specify carving position in Y direction 

⑨ Carving Z position Specify carving position in Z direction 

⑩ Carving Shape Selection Select carving shape 

⑪ Carving Shape Selection Select carving area: Inside the specified area or Outside the 

specified area 

⑫ Move to Center Move to Center the carving volume 

⑬ Undo Button Return to one previous state 

⑭ Execute Button Execute extraction 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 

⑪ 

⑫ 
⑬ ⑭ 
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4.7.3 Operation Guide  
 

○ Decide carving area 

Decide carving size according ①-③. decide carving position according to ⑦-⑨; decide  

carving angle according to ④-⑥. The rectangle on display indicates the output 3D size. 

 

○ Select carving shape 

Select carving shape from cylinder, rectangle and sphere in ⑩. When selecting cylinder, the  

domain size in X, Y direction is often the same. When selecting sphere, the domain size in  

X,Y direction is often the same. 

 

○ Select carving domain 

With the output scope，make selection between Inside (the specified scope ) and Outside (the  

specified scope). When selecting Inside in ⑪, the object should be handled inside the  

specified scope. When selecting Outside in ⑪, paint the specified area with the minimum  

value of 3D screen.  

When selecting Inside(Keep Size) in ⑪, it extracts within the specified range without 

changing the image size. 

When Inside (Change Coordinate System) is selected, a volume image tilted so that only the 

selected area is included is generated. At this time, it isotropically voxelized (numerical 

values of X, Y, Z pitch are same with the same numerical value) with the numerical value 

input to Pitch. The initial value of Pitch is set to the smallest value among the X, Y, Z pitch 

width of the original image. 

 

○Return to one previous state 

After executing the fill process, ⑬ the [Undo] button is enabled. 

If you press the [Undo] button, you can return to the previous state. 

 

 



Volume Extractor Version 3.0 Operation Manual 62 

4.8 Any Shape Delete (3D) 
From [Edit] menu, select [Volume Segment]. 

 

4.8.1 Function Outline 
Shape specified on screen, and cut out part of 3D image (area delete). 

 

4.8.2 Screen Description 

 
No. Items Descriptions 

① Rectangle Specify the area to be deleted rectangle 

② Ellipse Specify the area to be deleted ellipse 

③ Polygon Specify the area to be deleted polygon 

④ Curve Specify the area to be deleted curve. The region 

surrounded by the curve will be deleted 

⑤ Freehand Specify the area to be deleted freehand 

⑥ Inside Delete the inside of the specified area 

⑦ Outside Delete the outside of the specified area 

⑧ Clear Clear segment area 

⑨ Undo Return to one previous state 

⑩ Execute Execute segmentation 

⑪ Segment Area Specify the segment area in XYZ direction 

① 

② 

③ 

④ 

⑤ 

⑥ ⑦ 

⑧ 

⑨ 

⑩ 

Figure 4.8.2 Area selection and cut-out by any shape 

⑪ 

Figure 4.8.1.1 Select Delete Area Figure 4.8.1.2 Delete Result 
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4.8.3 Operation Guide 
○ Specify delete area 

1. Choose shape of erased area from ① - ⑤ 

2. Left-click anywhere on the three-dimensional view 

3. Mouse were moved, and then left-click the next point 

4. Delete area and then right-click if you turned to the shape you want. It confirms the 

deleted area in this work 

※ In the case of rectangle(①) and ellipse(②), area designation will be completed in two clicks 

※ In the case of polygons(③), curves(④) and freehand(⑤), drawing will continue until you 

right-click 

※ In the case of a free hand, drag in will create a straight line from the point of any line, in the 

mouse movement you release the left button at the end 
5. Repeat 1-4, you can specify more than one area (Figure 4.8.3.1) 

6. If you want to clear the inside of the area ⑥, if you want to erase the external area, 

select ⑦. (Figure 4.8.3.2) 
 

○ Edit delete area 

1. Align the mouse button on the handle(■) 

2. When the color of the handle is changed, and then drag (Figure 4.8.3.3) 

※ freehand areas are cannot be edited 
 

 

Figure 4.8.3.1 Specify delete areas Figure 4.8.3.2 Reverse delete areas 

Figure 4.8.3.3 Edit Delete area 
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4.9 Slice Direction Reversion 
Form [Edit] menu, select [Reverse X] [Reverse Y], and [Reverse Z]. 

After selection, make execution right away. It will return to its original state if the reverse is 

done twice. 

 

Form [Edit] menu, select [Reverse X] [Reverse Y], and [Reverse Z]. 

After selection, make execution right away. It will return to its original state if the reverse is 

done twice. 

 

 

4.9.1 Function Outline 
The following case is Head/Feet reversion of volume data that is done according to  

[Reverse Z]. 

 

 
Figure 4.9.1 Reversion Case 
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4.10 Volume Rendering 

Select [Volume Rendering] in [Tools] menu.  

  

4.10.1 Function Outline  
Its task is to divide the general brightness of volume data into several areas, specify each 

area’s color and brightness and display them in 3D image. It can also save the specified 

color and brightness (These parameters are called transfer function) in files for future use. 

After inputting volume rendering, make brightness work as a domain and specify color and 

transparency according to the environment setting. With regard to environment setting of 

volume rendering, refer to [Volume Rendering] in Chapter 6 [Various Setting]. 

   

○ Handled Case  

Handled Case of color and brightness specification through volume rendering  

(As shown in Figure 4.10.1) 

 

 

Before setting 

After setting 

Figure 4.10.1 Rendering result 
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4.10.2 Screen Illustration  

 
 

No. Items Descriptions 

① Preset Selection  Make preset selection  

(As for how to make preset file, Preset Folder of  

[Volume Rendering] in Chapter 6 [Various Setting]  

② Preset Switch Make a switch between Preset and Non Preset 

③ Graph  Specify histogram and color, display a diagram of brightness 

curves, move the brightness point up and down in left track...  

④ Minimum Brightness Indicate the minimum brightness of volume rendering 

⑤ Maximum Brightness Indicate the maximum brightness of volume rendering 

⑥ Transparency Track Bar With right side click, a new item is added. With left side 

click, the item is deleted. A new item can be moved upward 

and downward with left track 

⑦ Visible 

(Visible State Switch) 

Specify the area visibility of the selected transparency and 

the next transparency
*4.10.1

 

⑧ Value 

(Transparency) 

Specify the transparency of the selected block
*4.10.1

 

 

⑨ Level(Alpha) 

(Brightness box) 

Input Key for indicating brightness of transparency of the 

selected block. Change the number with spin button
*4.10.1

 

⑩ Shade Track Bar Add new shade with right side click and delete the new one 

with left side click. This bar can be 

dragged from left to right or vice versa 

⑪ Color 

(Color Change) 

Change to selected color
*4.10.1

 

⑫ R 

(R element) 

Input key for indicating R element of the selected color. 

It can be changed by spin button
*4.10.1

 

⑬ G 

(G element) 

Input key for indicating G element of the selected color. 

It can be changed by spin button
*4.10.1

 

⑭ B 

(B element) 

Input key for indicating B element of the selected color. 

It can be changed by spin button
*4.10.1

 

⑮ Level(Color) 

(Color Brightness Box) 

Input key for indicating brightness. It can be changed by spin 

button
*4.10.1

 

① 

② 
③ 

④ ⑤ 
⑥ 

⑦ ⑧ ⑨ 

⑩ 

⑪ ⑫ ⑬ ⑭ ⑮ 

⑯ ⑰ ⑱ ⑲ 

⑳ 

Figure 4.10.2 Volume Rendering Form 
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No. Items Descriptions 

⑯ Save 

 

Indicate the form of folder that saves present transfer 

function. 

⑰ Load 

 

Indicate form for reading files of transfer function (As shown  

in Figure 4.10.4) 

⑱ Shading In the case of a rendering, it is set up whether shade 

attachment is performed. 

⑲ Auto Update Each specified change will indicate if rendering is needed or 

not. 

⑳ Update Make rendering of the present specified item. 

 

*4.10.1 Timing for the possible control 

In terms of controls of ⑦⑧⑨ and ⑪～⑮, it can work only when one 

single item is selected, but it will not work well if two or more items are 

selected at the same time.  

 

 
  

No. Items Descriptions 

①  Transfer Function File  

Saving Directory 

Display the directory name of each save transfer 

function file. 

②  Directory Change Display the directory selection dialogue for 

directory change. 

③  Directory Moving  Move to upper level directory. 

④  Transfer Function File 

List 

Display Transfer Function File List in the directory. 

⑤  Comment Box  Input the comments for saved transfer function file 

⑥  File Name Box Input the name of transfer function file 

⑦  Save 

 

Save transfer function file in specified information 

( file name, comments and preview image) 

⑧  Preview Image  Display the preview image saved in transfer 

function file. 

⑨  Image File Name Box 

 

Display the preview image name of transfer 

function file. 

⑩  Image File Change Box Display the dialogue for preview image selection. 

 

⑪  Use Capture Image 

 

Use the captured image of WorkForm in image 

previewing. 

   

  

① ② ③ 

④ 

⑤ 

⑥ ⑦ 

⑧ 

⑨ ⑩ 
⑪ 

Figure 4.10.3 Transfer Function Saving Form 
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No. Items Description 

①  Transfer Function File 

Reading Directory 

Display directory name of transfer function file 

②  Directory Change Display the directory selection dialogue for directory change 

③  Directory Moving Move to upper level directory 

④  Transfer Function File 

List 

Display Transfer Function File List in the directory 

⑤  Comment Box Display the comments for transfer function file selected in ④ 

⑥  Input File Box  Display transfer function file name 

⑦  Load Load the transfer function file selected in ④ 

⑧  Preview Image  Display the preview image of transfer function file selected in 

④ 

⑨  Image File Name Box 

 

Display the preview image name of transfer function file 

selected in ④. It will be a blank space if it is not specified 

 

② ③ 

④ 

⑤ 

⑥ ⑦ 

⑧ 

⑨ 

① 

Figure 4.10.4 Reading Transfer Function Form 
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4.10.3 Operation Guide 
 

○ Divide the brightness distribution area
*4.10.2 

 

1. Click transparency track bar on the left side and a new button will be added. 

(As shown in Figure 4.10.5) 

 

On the graph click [Ctrl] key, a new item can also be added. 

(As shown in Figure 4.10.6) 

 

The clicking position is set between the minimum brightness and maximum brightness 

at the graph bottom. The brightness distribution area is divided into two domains by the 

button. 

 

In selection status for adding slider (Unselected is △ while Selected is △), indicates 

brightness in brightness box. 

 

2. Use the track bar to move the slider leftward or rightward to change the slider 

brightness. 

 

*4.10.2 Domain Division 

It means using slider to divide brightness. One domain refers to the 

interval between one brightness slider and the next brightness slider. 

Transparency is specified in sliders. Brightness without sliders is applied 

to slider transparency. 

 

 

 
Figure 4.10.5 Transparency Increase  

 

 
Figure 4.10.6 Transparency Increase on the graph 
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○ Select multiple points 

1. Click the starting slider on the transparency bar or the starting point on the graph. 

(As shown in Figure 4.10.7) 

2. Shift clicks the starting slider on the transparency bar or the starting point on the graph. 

(As shown in Figure 4.10.8) 

 

 
Figure 4.10.7 Starting Point Selection 

 

 
Figure 4.10.8 Ending Point Selection 

 

 

○ Use rectangle to select multiple points (As shown in Figure 4.10.9) 

1. By dragging the selected scope on the graph, a half-transparent rectangle comes up on 

it. 

2. Once you release the mouse and stop dragging, you can select multiple points included 

in the rectangle. 
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Figure 4.10.9 Multiple Selection by using a rectangle 

 

○ Move multiple points on the graph 
*4.10.3

 (As shown in Figure 4.10.10) 

1. On the graph，drag the selected points and it will show what it looks like after moving. It 

is usually a horizontal movement. Shift key is for vertical movement and Alt key is for 

free movement 

2. If the mouse is released, dragging is finished and so is the movement 

 

*4.10.3 Multiple selected point determines multiple point movement. 

When making multiple point movement, points can be added 

automatically in order to save unselected points for transparency graph, 

However, points cannot added when moving one single point.  
 

 
Figure 4.10.10 Point Movement on the graph  

Drag and drop selected points 
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○ Set invisible domain 
*4.10.4

 

1. Left click track bar transparency and turn it into invisible domain 

2. Click [visible], turn off Check 

3. Click [Update] key 

 

*4.10.4 Invisible Domain 

It refers to the domain with 0 transparencies. When the beginning of this domain and 

the next transparency are marked as 0, it means the domain disappears, which is 

called “Zero Transparency” state. To make it invisible, turn off [visible] Check at the 

beginning of the domain. 
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○ Color Setting 

1. When left clicking the color track bar, a slider is added. (As shown in Figure 4.10.11) 

2. The added slider stays in selection status, which indicates brightness in color slider 

brightness box. 

3. Move the slider leftwards or rightwards with left track bar to change slider brightness. 

4. Double click the slider to be changed to change its color or click [Color] key to display 

[Color Setting] form (As shown in Figure 4.10.12) 

 

 
  Figure 4.10.11 Color Slider Addition 

 

 
Figure 4.10.12 Color Setting Form 

 

○ It makes automatic updating valid 

1. Click [Auto Update] key, turn on Check box 

2. In WorkForm, if it is in volume displaying state, every slider changing by this color 

setting will make volume rendering possible 

 

○ Save transfer function file with comments 

1. Click [Save] key and display transfer function saving format 

2. Input comments into comment box 

3. Input file name and click [Save] key 
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Figure 4.10.13 Comment Form of transfer function file 

 

○ Save the specified transfer WorkForm capture as function file preview image 

1. Click [Save] key and display transfer function saving form 

2. Click [Use Capture Image] and turn on Check (As shown in Figure 4.10.14) 

3. Input file name and click [Save] key 

 

 
Figure 4.10.14 Specify preview icon of transfer function file 1  

 

○ Save the specified original image file as transfer function file preview image 

1. Click [Save] key and display transfer function saving form 

2. Click image file change button (As shown in Figure 4.10.15), Use the displayed form, 

i.e. open the file to specify image file 

3. Input file name and click [Save] key 

 

 
Figure 4.10.15 Specification of Preview Icon of Transfer Function File 2  

 

○ Load transfer function specification 

1. Click [Load] key and display transfer function loading form 

2. Select a file from transfer function preview list (As shown in Figure 4.10.16),  

click [Load] button 

3. In loading setting, insert a renewing slider. If the system is in WorkForm with volume, 

display, volume rendering can be performed 

 

 

Input Comment 

Click [Use capture Image] item 

Click change image file 
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Figure 4.10.16 Transfer Function File Selection 

 

 

 

 

 

 

 

 

 

 
Figure 4.10.17 Insertion Changing Case  

 

 

*4.10.5 What is Insertion Renewal 

When making slider setting file with volume data of different brightness 

distribution, make slider insertion by maintaining the slider position relation 

to match the present brightness. When using brightness distribution between 

50~232 to load files set on brightness distribution between 0~637, each 

slider’s brightness will be changed. (As shown in Figure 4.10.17) 

Click input transfer function file 



Volume Extractor Version 3.0 Operation Manual 76 

4.10.4 Environment Setting  
 

○ Cross-section Displaying Form 

1. Right click on graph and menu will come up (As shown in 4.10.18) 

2. Select [Normal] or select standard form [Logarithm] and use log to display graph 

 

 
Figure 4.10.18 Contrast menu 
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4.11 Point-Based Volume Rendering 

Select [Point-Based Volume Rendering] in [Tools] menu or click tool bar . 

 

4.11.1 Function Outline  
In concept, point-based volume rendering is the same as [Volume Rendering] in 4.10. 

However, displaying approaches are different. In point-based volume rendering, each Voxel 

is illustrated by cube points. But according to the date pitch, points toward Z position can be 

automatically adjusted. 

 

○ Result Handled Case 

Specify color and brightness to display rendering results. (As shown in 4.11.1) 

 

 
Figure 4.11.1 Rendering Result 

 

 

*4.11.1 Point adjustment towards Z position 

In point rendering, voxel is displayed through cube points. Therefore, there is a huge 

difference between the pitch towards X and Y position and the pitch towards Z position. 

With such a big data difference, the points towards Z position can be possibly far from 

each other.  

When inserting new points between other points (As shown in Figure 4.11.2), adjust the 

new points so that no crack could appear in volume. 
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Figure 4.11.2 Point Adjustment towards Z point 

 

Same pitch among X,Y,Z 

X，Y pitch＜Z pitch 

Insert point in the space 

Z 

X 

 

Y 
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4.11.2 Screen Description  
 

 
Figure 4.11.3 Volume Rendering  

 

No. Items Descriptions 

① Preset Selection Make preset selection 

Regarding preset file setting, refer to Preset Folder of 

[Volume Rendering] in Chapter 6 [Various Setting] 

② Preset Switch  Switch between Preset and Non Preset 

③ Graph  Display brightness histogram and transparency  

curved line graph and transparency points by   

moving up and down on the left track 

④ Minimum Brightness Display the minimum brightness of volume data 

⑤ Maximum Brightness Display the maximum brightness of volume data 

 

⑥ Transparency Track Bar Add a new slider by making a right-side click 

Delete a slider by making a left-side click 

Sliders can be dragged from side to side by left track 

⑦ Visible 

(Visible State Switch) 

Specify if the domain is visible or not from the  

selected transparency slider to next transparency 

slider 

⑧ Value 

(Transparency) 

Specify transparency of selected sliders. 

⑨ Level (Alpha) 

(Transparency Slider 

Brightness Box) 

Display brightness of selected transparency sliders. 

Input the key or use sliders to change value 

⑩ Color Track Bar  Add a new slider by making a right-side click 

Delete a slider by making a left-side click 

Sliders can be dragged from side to side by left track 

⑪ Color 

(Color Change) 

Change the color of the selected slider 

 

⑫ R 

(R element) 

Display R element of selected slider color 

Input the key or use the spin button to change it 

⑬ G 

(G element) 

Display G element of selected slider color 

Input the key or use the spin button to change it 

⑭ B 

(B element) 

Display B element of selected slider color 

Input the key or use the spin button to change it 

① 
② ③ 

④ ⑤ 
⑥ 

⑦ ⑧ ⑨ 

⑩ 

⑪ ⑫ ⑬ ⑭ ⑮ 

⑯ ⑰ 

⑱ 
⑲ 

⑳ 
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No. Items Descriptions 

⑮ Level (Color)  

Color Slider Brightness Box  

Display brightness of selected slider color 

Input the key or use the spin button to change the 

number 

⑯ Save Display the form for saving the present transfer 

function file (As shown in 4.11.4) 

⑰ Load 

 

Display the form for loading transfer function file 

(As shown in 4.11.5) 

⑱ Rendering Area Display the form for limiting described areas 

(As shown in 4.11.6) 

⑲ Auto Update Specify if each slider change setting is rendered or 

not 

⑳ Update Use the current setting for rendering 

 

 

 
Figure 4.11.4 Transfer function Saving Form  

 

No. Items Descriptions 

①  Transfer Function 

File Saving 

Directory 

Display directory name of transfer function saving file 

②  Directory Change Display the directory selection dialogue for changing the 

transfer function file directory 

③  Directory 

Movement  

Move to upper level directory 

④  Transfer Function 

File List  

Display transfer function file list saved in directory 

⑤  Comment Box  Input transfer function file comments written unto saved 

transfer function file 

⑥  File Name Box  Input transfer function file name 

⑦  Save  Save transfer function file of specified information such 

as file name, comments and preview image 

⑧  Preview Image  Display preview image of transfer function file to be 

saved 

⑨  Image file name 

box 

Display preview image file name of transfer function file 

to be saved 

⑩  Image File Change  Display dialogue for preview image selection 

⑪  Use Image Capture  Use the captured WorkForm for image previewing 

                    

         

① ② ③ 

④ 

⑤ 

⑥ ⑦ 

⑧ 

⑨ 

⑪ 

⑩ 
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Figure 4.11.5 Transfer Function Loading Form  

 

No. Items Descriptions 

①  Loading Transfer 

Function 

Directory 

Display directory name of transfer function files 

②  Directory Change Display the directory selection dialogue for changing 

transfer function file directory 

 

③  Directory 

Movement  

Move to upper level directory 

④  Transfer Function 

File List  

Display transfer function file list saved in directory 

⑤  Comment Box Display comments of transfer function selected in ④ 

⑥  File Input Box Display transfer function file name 

⑦  Load Load transfer function selected in ④ 

⑧  Preview Image  Display the image of transfer function file selected in 

④ 

⑨  Image File Name 

Box 

Display the image name of transfer function file selected 

in ④. It is blank if not specified 

 

① ② ③ 

④ 

⑤ 
⑥ ⑦ 

⑧ 

⑨ 
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Figure 4.11.6 Transfer Function Loading Form 

 

 

No. Items Descriptions 

① Painting Area 

towards X bar 

Click the slider and specify two moveable sliders: maximum and 

minimum of painting area towards X direction 

② Maximum 

Painting Area 

towards X bar  

Specify the maximum value of painting area towards X direction 

③ Minimum Painting 

Area towards X 

bar  

Specify the minimum value of painting area towards X direction 

④ Painting Area 

towards Y bar  

Click the slider and specify two moveable sliders: maximum and 

minimum of painting area towards Y direction 

⑤ Maximum 

Painting Area 

towards Y bar  

Specify the maximum value of painting area towards Y direction 

⑥ Minimum Painting 

Area towards Y 

bar  

Specify the minimum value of painting area towards Y direction 

⑦ Painting Area 

towards Z bar  

Click the slider and specify two moveable sliders: maximum and 

minimum of painting area towards Z direction 

⑧ Maximum 

Painting Area 

towards Z bar  

Specify the maximum value of painting area towards Z direction 

⑨ Minimum Painting 

Area towards Z 

bar  

Specify the minimum value of painting area towards Z direction 

⑩ Painting Density Specify the voxel pitch in painting 

[High] No voxel; [Middle] one voxel; [Low] two voxels 

⑪ Painting Point 

Size  

Specify the point size in painting. If default is [Middle], then 

[Middle]’s point size is 100%, [Low] is 67% and [Big] is 250% 

 

① ② 

③ 

④ ⑤ 

⑥ 

⑦ ⑧ 
⑨ 

⑩ 

⑪ 
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4.11.3 Operation Guide 
 

○ In terms of transfer function adjustment, saving and loading, its function is the same as  

that of volume rendering refer to 4.10 Volume Rendering for more detailed information. 

 

○ Setting Painting Area  

1. Click [Rendering Area…] key and the painting area setting form will be displayed 

2. Move the painting areas towards X, Y, Z direction by moving track bar slider on the left 

track (As shown in Figure 4.11.7) 

 

 
Figure 4.11.7 Painting Area Setting 

Move the slider of the track bar 
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○ Painting Density Setting 

1. Click [Rendering Area...] to display setting form of painted areas 

2. Click the button for painting density to choose density. (As shown in Figure 4.11.8) 

 

 
   Figure 4.11.8 Painting Density Setting 
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○ Setting painting point size 

1. Click [Rendering Area...] key to display setting form of painted areas 

2. Click point size button to choose points size. (As shown in Figure 4.11.9) 

 

 
Figure 4.11.9 Point Size Setting  
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4.11.4 Setting  
○ Switch displaying form 

1. Make a right-side click on the graph to display a detailed menu 

(As shown in Figure 4.11.10) 

2. Normal means standard form while [Logarithm] is log form 

 

    
Figure 4.11.10 Contrast Menu 
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4.12 Iso-Surface  

In [Tools] menu, select [Iso-Surface] or click tool bar ｡ 

 

4.12.1 Function Outline 
Extract brightness and iso-element from volume data. This element, together with the 

adjacent elements, will be connected making a triangle surface which will become a polygon 

data. This polygon data enables mesh editing, file output and other applications to become 

possible.  

 

○ Result Handled Case 

Displaying Iso-Surface Generation Result. (As shown in Figure 4.12.1) 

 

 
Figure 4.12.1 Generation Result 

Volume Data 

Polygon Data 

Create an equivalent plan 
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4.12.2 Screen Description 

 
 

No. Items Descriptions 

① Constant C 

 

Specify the extracted brightness as iso-surface 

② Ratio of Data 

Reduction 

 

Specify reduction rate of volume data
*4.12.1

 

③ Preview Preview and display iso-surface value generated 

by the present Constant C and iso-value 

brightness 

④ Slice number In the case of a 2D preview display current slice 

number. The display shows what the current 

image slices, and the slide bar and the switching 

value input by the possible 

In the case of D preview, this operation is 

disabled. 

⑤ View Direction 

 

Specify the ongoing view direction 

⑥ Preview Mode 

 

Select preview 2D slice image or 3D slice image. 

In the 2D slice image, ON / OFF of the window 

level function it is also possible 

⑦ Closed Boundary 

 

When volume data has broken off by the end side 

of space, it is chosen whether an iso-surface is 

closed  

⑧ 3D Printer Mode 

 

If you want to output the shape file of 3D printers, 

reduce the miscalculation of support and 

modeling at the time of the 3D printer is set to 

ON 

⑨ Num of Polygon  

(Iso-surface 

Generation 

Number) 

Display iso-surface generation number 

⑩ Delete  

(Delete 

Iso-surface)  

Delete iso-surface generation  

③ 

② 

① 

④ 

⑤ 

⑥ 

⑦ 
⑧ 

⑨ 

⑩ ⑪ 

Figure 4.12.2 Iso-surface form 
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No. Items Descriptions 

⑪ Execute  

(Iso-surface 

Generation) 

Use the present setting to generate iso-surface 

 

*4.12.1 Reduction Rate of Volume Data 

   Reduction rate of volume data will affect the quality of iso-surface 

generation. If the reduction rate becomes smaller, the generation time 

will be shortened and the generated surface will become rough. If the 

reduction rate becomes bigger, the generated surface will become 

smooth and delicate even if the generation time takes longer.  
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4.12.3 Operation Guide 
○ Iso-Surface Generation Drag 

1. [Constant C] track bar and input Constant C. 

2. The preview will vary with different Constant C. (As shown in 4.12.3) 

3. If you want to see the preview from other direction, click [Direction] key to change 

previewing direction. (As shown in 4.12.4) 

4. Click [Ratio of Reduction] key to input reduction number. 

5. Click [Closed Boundary] key to choose an iso-surface is closed. (As shown in 4.12.5) 

6. Click [3D Printer Mode] key to choose an output suitable for modeling in 3D Printer. 

(As shown in 4.12.6) 

7. Click [Execute] key. 

8. Display the generated result in WorkForm. 

 

 
 

 
Figure 4.12.4 Change of Previewing Direction 

Figure 4.12.3 Change of Constant C 
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○Preview from 2D, generate the equivalent surface 

1. The Preview Mode switch to 2D (As shown in 4.12.7) 

2. Preview of any field. The upper left corner of the cursor is currently represented by the 

brightness value of the image. In that state, the value of the constant C is changed. At 

this time, the constant C expressed in accordance with the equivalent surface of the 

display line (contour). (As shown in 4.12.8) 

3. In WindowW / L check box is possible ON / OFF of the window level function. This 

function is linked with the dialog operation of the "4.22 WindowW / L". (As shown in 

4.12.9) 

4. Switch the current serial number, enter the value of the slider. (As shown in 4.12.10) 

5. If you want to see it from another angle. Please select the radio button (Direction) to 

change direction (As shown in 4.12.11) 

6. Drag the Track bar to input the date of [Ratio of Data Reduction] 

7. [Closed Boundary] Choose whether to close the check box 

8. [3D Printer Mode] Select the check box for the 3D printer's model for the appropriate 

output 

9. [Execute] Click the button below 

10. Represents the result of a worksheet (As shown in 4.2.12) 

 

Figure 4.12.5 Change of the border plane in "Closed Boundary"OFF/ON 

Figure 4.12.6 Change of the border plane in "3D Printer Mode"OFF/ON 
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Figure 4.12.8 Preview 2D image contour generation 

Figure 4.12.7 Preview type conversion 
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Figure 4.12.9 Preview WindowLevel ON / OFF image 

Figure 4.12.10 Change of serial number representation 
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Figure 4.12.11 Preview direction changes (2D) 

Figure 4.12.12 Preview 2D's equivalent surface generation 
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4.13 Index Image 
 

4.13.1 Index Image 

In [Tools] menu, select [Index Image] or click tool bar . 

 

4.13.1.1 Function Outline 

It can divide the overall brightness of volume data into several domains and make color 

specification for each domain and display them in 3D image. The specified color can be 

reused again if saved. After inputting volume data, each brightness is seen as a domain 

which is set between the minimum and maximum position. As for index image setting, refer 

to Index Image in Chapter 6 [Various Setting]. 

Unlike volume rendering
*4.13.1

, the color of each slider is constant. 

 

*4.13.1 Difference between volume rendering and index image 

Volume rendering uses transparency and color for line insertion within the 

specified domain while index image uses a specified color within the domain. 

In index image, there is no concept like transparency, but there is only a choice 

between Visible and Invisible.  

 

 

○ Result Handled Case  

Rendering Result of specified color. (As shown in Figure 4.13.1) 

 

 
Figure 4.13.1 Rendering Result 
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4.13.1.2 Screen Description 

 

 
Figure 4.13.2 Index Image Form 

 

No. Items Descriptions 

①  Preset Selection  Make presetting selection 

(As for presetting file setting, refer to [Preset Folder] of  

[Volume Rendering] in Chapter 6 [Various Setting] 

②  Preset Display 

Switch 

Switch between Preset Display and Non Display 

③  Graph  Display brightness histogram, color setting and visible curved line 

graph 

④  Brightness 

Minimum 

Display the minimum brightness of volume data 

⑤  Brightness 

Maximum 

Display the maximum brightness of volume data 

⑥  Color Setting Track 

Bar  

Click on the right and a new slider is added. Click on the left and 

the new slider is deleted. The slider can be moved from side to 

side by left track bar 

⑦  Visible  

(Switch between 

Visible and 

Invisible state) 

To show if it is visible or not from the selected color slider to the 

next one 

⑧  Color  

(Color Change) 

Change the color of selected slider 

⑨  R element  Display R element of selected slider color 

Input the key or use the spin button to change it 

⑩  G element Display G element of selected slider color 

Input the key or use the spin button to change it 

⑪ B element Display B element of selected slider color. 

Input the key or use the spin button to change it 

⑫ Level  

(Color Slider 

Brightness Box) 

Display brightness of selected color slider 

Input the key or use the spin button to change it 

⑬ Save Save the present transparency and color slider setting in the file 

⑭ Load Load color slider setting from the file 

⑮ Segmentation  Display segmentation form 

See 4.13.2 [Segmentation] for more information 

① ② ③ 

④ ⑤ 
⑥ 

⑦ ⑧ 
⑨ ⑩ ⑪ ⑫ 

⑬ ⑭ 
⑮ 

⑯ ⑰ 

⑱ 
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No. Items Descriptions 

⑯ Shading In the case of a rendering, it is set up whether shade attachment is 

performed 

⑰ Auto Update  

(Auto Update 

Switch) 

Specify t if each slider changes setting is visible or not 

⑱ Update  Make rendering on the present setting 

 

 
Figure 4.13.3 Transfer Function Saving Form 

 

 

 

No. Items Descriptions 

①  Transfer Function 

File Saving 

Directory 

Display directory name of transfer function saving file 

 

②  Directory Change Display the directory selection dialogue for changing the transfer 

function file directory 

③  Directory 

Movement 

Move to upper level directory 

④  Transfer Function 

File List 

Display transfer function file list saved in directory 

⑤  Comment Box Input transfer function file comments written unto saved transfer 

function file 

⑥  File Name Box Input transfer function file name 

⑦  Save 

 

Save transfer function file of specified information such as file 

name, comments and preview image 

⑧  Preview Image Display preview image of transfer function file to be saved 

⑨  Image file name 

box 

Display preview image file name of transfer function file to be 

saved 

⑩  Image File Change Display dialogue for preview image selection 

⑪  Use Image Capture Use the captured WorkForm for image previewing 

                    

 

         

① ② ③ 

④ 

⑤ 
⑥ ⑦ 

⑧ 

⑨ ⑩ 

⑪ 
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Figure 4.13.4 Transfer Function Loading Form  

 

No. Items Description 

①  Transfer Function 

File. 

Reading Original 

Directory 

Display directory name of transfer function file 

②  Directory Change Display the directory selection dialogue for directory 

change 

③  Directory Moving Move to upper level directory 

④  Transfer Function 

File List 

Display Transfer Function File List in the directory 

⑤  Comment Box Display the comments for transfer function file 

selected in ④ 

⑥  Input File Box Display transfer function file name. 

⑦  Load Load the transfer function file selected in ④ 

⑧  Preview Image Display the preview image of transfer function file 

selected in ④ 

⑨  Image File Name Box 

 

Display the preview image name of transfer function 

file selected in ④ 

It will be a blank space if it is not specified 

 

 

① ② ③ 

④ 

⑤ 

⑥ ⑦ 

⑧ 

⑨ 
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4.13.1.3 Operation Guide 

 

○ Brightness distribution is divided into several domains to specify color for each domain. 

1. Make a left-side click on the color track bar to add new sliders (As shown in 4.13.5) 

Clicking position is between the minimum and maximum brightness at the bottom of 

graph. Brightness distribution is divided into two domains because of slider addition 

2. When the added slider stays in selection state, it indicates brightness in slider brightness 

box 

3. When changing slider brightness, drag the slider from side to side on left track bar 

4. When changing slider color, click [Color] key to display [Color Setting] form 

   

 
Figure 4.13.5 Color Slider Addition 

 

○ Setting an Invisible Domain (see 4.10 Volume Rendering 4.10.2) 

1. It turns into selection state by clicking the color track bar on the left if you don’t want to 

see the domain 

2. Click [Visible] key to turn off [Check] 

3. Click [Update] key 

 

○ Validating automatic updating 

1. Click [Auto Update] to turn on [Check] 

2. When volume is displayed in WorkForm, rendering is finished on each slider change 

 

○ Setting slider saving 

1. Click [Save] key to display [Save with Attached Name] form 

2. Input file name and click [Save] button 

 

○ Setting loading slider 

1. Click [Load] button to display [Open files] form 

2. Input file names and click [Open] button 

3. Insert a new spin slider while loading setting. (For more information, refer to 4.10.3 

Operation Guide – [Loading Transfer Function Setting]). Rendering is done in volume 

WorkForm 

Left click add 

Area2 Area1 
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4.13.1.4 Setting   

   

○ Switch Display Form 

1. Click the right side button on the graph to show a detailed menu 

(As shown in 4.13.6) 

2. [Normal] means Standard Form while [Logarithm] is log form 

 

 
Figure 4.13.6 Contrast Menu 

 

4.13.2 Segmentation  
Click [Segmentation] button in [Index Image] form. 

 

4.13.2.1 Function Outlines 

Change the brightness value in different domains made with an index image. 

It can concentrate on one of the brightness value of all the domains. The specified brightness 

value varies according to volume data.
*4.13.2

 

 

*4.13.2 Data Type 

Volume data will have different brightness area because of data type. 

Confirm [data type] with [File Information] in [Tools] menu. 

 

Data Type 1:0~255 

Data Type 2: 0~65535 

Data Type 3:-32768~32767 

Data Type 4:-2147483648~2147483647 

 

○ Result Handled Case 

Domain with brightness value between 100~299 is changed into domain with brightness 

value 150. (As shown in Figure 4.13.7) 
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Figure 4.13.7 Segmented Result 

 

 

4.13.2.2 Screen Description 

 
Figure 4.13.8 Segmentation Form 

 

No. Items Descriptions 

①  Area List The list shows the minimum and maximum  

brightness value of each domain 

②  Parameter Change 

Setting 

It indicates setting change of each domain 

③  Edit  

Brightness Value 

Input Setting  

Specify brightness value change according to the  

input value in Area List 

④  Brightness Input 

Box 

Input brightness number to be changed 

Brightness be 100~299 

Set brightness to 200 

① ② ③ ④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ ⑩ 
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No. Items Descriptions 

⑤  No change Setting   Specify No Change in brightness with Area domain 

⑥  Minimum  

Brightness Setting  

Change the present volume data into minimum 

brightness in Area Domain 

⑦  Maximum 

Brightness Setting  

Change the present volume data into maximum 

brightness in Area Domain 

⑧  Zero Setting Change the present volume data into Zero brightness in 

Area Domain 

⑨  Execute  Do segmentation in present setting 

⑩  Reset  Return to the post-segmentation state 

 

4.13.2.3 Operation Guide  

○ Make setting according to domain brightness number.  

1. In Area List, select the domain that needs to change brightness number. Click [Edit] 

button 

2. Input the changed brightness number into brightness box 

 

○ Make segmentation
*4.13.3 

1. After the domain setting is finished, click [Execute] button, but [Execute] button cannot 

be used for segmentation if all the brightness becomes one same number 

2. Confirm histogram both before and after segmentation in index image form 

3. Click [Reset] point, segmentation is deleted and it returns to its initial state 

 

 
   Figure 4.13.9 Contrast of Histogram Graph 

 

         

*4.13.3 Slider Position after segmentation 
Basically, the brightness value of segmentation slider does not change. 

(As shown in Figure 4.13.10) 

As an exception, if brightness number is set beyond brightness 

distribution before segmentation, the brightness of outmost slider will 

be changed. (As shown in Figure 4.13.11) 

After execution 

Before execution 
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  Figure 4.13.10 Case of Unchanged Slider Brightness 

Brightness between 100~ 199 

Set brightness to 250 

No change on the bar 

0     100    200   300 
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     Figure 4.13.11 Changed Slider Brightness 

 

Brightness between 100~ 199 

Set brightness to -100 

The slider on left change from 0 to 

-100 

0     100    200    300 
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4.14 3D Cross Section 
 

○ Control Form 

In [Tools] menu, select [Cross Sections] or click tool bar of Main Frame . 

 

○ Display 

Click WorkForm Tool Bar . 

 

4.14.1 Function Outline 
○ Control Form 

Display position adjustment form of cross section. 

In form, switch between Display and Non Display and make slice selection. 

Specified Pitch and Yaw, you can change the angle of cross-selected image. 

Cross section specified here will be reflected in the display of MeasureView. 

If the loading data of a plane, lines or points is not volume data, this function will not work. 

 

○ Display 

In WorkForm, the cross-selected image is displayed in density. 

Density decomposition is specified according to Resolution of [Volume Rendering]  

in Chapter 6 [Various Setting]. 

If the loading data of plane, lines or points is not volume data, this function will not work. 

 

4.14.2 Screen Description 
 

○ Control Form  

 

 
 Figure 4.14.1 3D Cross Section Control Form 

 

 

No. Items Descriptions 

①   YZ Plane  

Display Graph 

Switch between YZ Plane Display and Non Display 

 

②  XZ Plane  

Display Graph 

Switch between XZ Plane Display and Non Display 

 

③  XY Plane  

Display Graph 

Switch between XY Plane Display and Non Display 

④  YZ Plane Position Set YZ plane position 

⑤  XZ Plane Position Set XZ plane position 

⑥  XY Plane Position Set XY plane position 

⑦  YZ Pitch Rotate Set YZ plane position 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 

⑪ 

⑫ 
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No. Items Descriptions 

⑧  XZ Pitch Rotate Set XZ plane position 

⑨  XY Pitch Rotate Set XY plane position 

⑩  YZ Yaw Rotate Set rotation angle of the YZ plane 

Pitch rotation, you can freely rotate the cross-section 

by a combination of Yaw rotation 

⑪  XZ Yaw Rotate Set rotation angle of the XZ plane 

⑫  XY Yaw Rotate Set rotation angle of the XY plane 

 

The cross-sectional image displayed on the WorkForm. 

Cross-sectional images works in conjunction with the display of MeasureView. 

This allows the display of the cross-sectional slice from any position and angle. 

 

 
Figure 4.14.2 3D Cross Section Display 

 

4.14.3 Operation Guide 
 

○ No displaying of YZ cross section  

Delete Check Box in ① of Control Form. 

 

○ Displaying YZ cross section 

Add Check Box in ① of Control Form. 

 

○ Move display position of YZ cross section 

Move control form ④ or specify the number of ⑦. 

 

4.14.4 Setting 
Refer to [Wireframe Color] in Chapter 6 [Various Setting]. 

In this function, you can switch between color and the visible invisible border that indicates 

the existence range of the cross-section. 
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4.15 Camera 

In [Tools] menu，select [Camera] or click tool bar . 
 

4.15.1 Function Outline 
It changes viewpoints on WorkForm. It is easier to understand and correct to operate because 

of the use of camera menu. In addition, the same operations can be done by means of mouse.  

 

○ Basic operation by using mouse to make 3D display. (spinning, enlarging and moving) 

1) Rotation of volume and polygon 

Make a rotation by dragging 3D displayed part. 

2) Zoom in and zoom out 

Zoom by dragging 3D displayed image to right. Zoom in by moving the mouse cursor 

upward and zoom out by moving the mouse cursor downwards. 

3) Move the camera upwards or downwards and from right side to left side 

Horizontal and vertical movement is made by pressing "Z" key and dragging 3D 

displayed image at the same time. 

In addition, the similar operation like cutting, rotating and moving can be made on any 

clipping plane by using mouse cursor. 

 

○ Simple Cutting Operation 

1) Clipping Plane Operation 

Click WorkForm icon . 

2) Clipping Plane Rotating 

Drag 3D displayed image by pressing Ctrl and make rotation on the original point. 

3) Clipping plane Moving 

Drag 3D displayed image by pressing Ctrl and move towards a normal line. 
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4.15.2 Screen Description 
○ Simple Screen Image 

 
  

No. Items Descriptions 

①  Preset Button 1 Move the viewpoint in the front 

②  Preset Button 2 Move the viewpoint at the back 

③  Preset Button 3 Move the viewpoint on the right 

④  Preset Button 4 Move the viewpoint on the left 

⑤  Preset Button 5 Move the viewpoint at the top 

⑥  Preset Button 6 Move the viewpoint at the bottom 

⑦  Rolling 1 Move the viewpoint to the specified angle, i.e. the right side 

⑧  Rolling 2 Move the viewpoint to the specified angle, i.e. the left side 

⑨  Rolling 3 Move the viewpoint to the specified angle, i.e. the top 

⑩  Rolling 4 Move the viewpoint to the specified angle, i.e. the bottom 

⑪ Rolling 5 The viewpoint spins towards the left 

⑫ Rolling 6 The viewpoint spins towards the right 

⑬ Parallel Movement 1 Move the viewpoint to the specified distance, i.e. the left side 

⑭ Parallel Movement 2 Move the viewpoint to the specified distance, i.e. the right side 

⑮ Parallel Movement 3 Move the viewpoint to the specified distance, i.e. the bottom 

⑯ Parallel Movement 4 Move the viewpoint to the specified distance, i.e. the top 

⑰ Angle and Distance Indicate angle and distance with ⑦-⑯ 

⑱ Detail 

Mode Switch 

Switch between Simple Screen and Detailed Screen 

⑲ Reset Reset viewpoint movement information 

 

Figure 4.15.1 Camera Form (Simple Illustration) 
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③ 
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○ Detailed Screen 

Introduce the functions of detailed screen. 

 
 

No. Items Descriptions 

①  Viewpoint 1 Specify viewpoint position on XY plane by number 

②  Viewpoint 1 

Track Bar  

Specify viewpoint on XY plane 

③  Yaw  

Display Viewpoint 1 

Display viewpoint position on XY plane 

④  Viewpoint 2 Specify viewpoint position on Z bar by number 

⑤  Viewpoint 2 

Track Bar  

Specify viewpoint position on Z bar 

⑥  Pitch  

Display Viewpoint 2 

Display viewpoint position on Z bar 

⑦  Camera Roll  

Viewpoint Roll 

Display viewpoint rolling by number 

⑧  Viewpoint Rolling 

Track Bar 

Specify viewpoint rolling 

⑨  Zoom  

Distance Track Bar 

Specify the distance between the object and the 

viewpoint 

⑩  View Mode  

Displaying Mode 

Switch between Parallel and Perspective 

 

Figure 4.15.2 Camera Form (Detailed Illustration) 
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③ 

④ 
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4.15.3 Operation Description 
 

○ Observe an object from the frontage 

Click [Preset Button 1] in ① of Simple Screen. 

   

○ Observe an object from the right  

Click [Preset Button 3] in ③ of Simple Screen. 

 

○ Observe an object from the top 

Click [Preset Button 5] in ⑤ of Simple Screen. 

 

○ Move the viewpoint 10°to the left 

1. Input 10 in ⑬ of Simple Screen and click [Rolling 2] in ⑧ of Simple Screen. 

2. Press [Rolling 2] again and it will roll 10°. 

    

○ Move the viewpoint 20°downwardst 

1. Input 20 in ⑬ of Simple Screen and click [Rolling 4] in ⑩ of Simple Screen. 

2. Press [Rolling 4] again and it will roll 20°. 

 

○ Roll 15°to the left 

1. Input 15 in ⑬ of Simple Screen and click [Rolling 5] in ⑪ of Simple Screen. 

2. Press [Rolling 5] again and it will roll 15°. 

 

○ Observe an object from backwards at 45° 

Input 135 in ① of Detailed Screen. 

 

○ Look down a point at 45° 

Input 45 in ⑤ of Detailed Screen. 

 

○ Push the object away  

Move distance track bar to the left. 
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4.16 File Information 
 In [Tools] menu, select [File Information]. 

 

4.16.1 Function Outline  
   Display File-information. 

   In addition, it can change the screen size and polygon size. 

 

4.16.2 Screen Description 
 

 
 

No. Items Descriptions 

① File name  Indicate a file name 

② Image Size  Indicate image size 

③ Start Point  

(Start Point  

Of Painting) 

Indicate the painting position of the object 

④ Pitch  

(Big and Small) 

Indicate one pixel size 

⑤ Grid Width  Indicate interval between pixels 

⑥ Polygon Scale  Indicate size number 

⑦ Data Type  Indicate data type 

⑧ Accession Number Indicate Accession Number of the client 

⑨ Patient’s Name Indicate the name of the patient 

⑩ Patient ID  Indicate the patient ID 

⑪ Patient’s Birth Date  Indicate birthday of the patient 

⑫ Patient’s Sex Indicate gender of the patient 

Figure 4.16.1 File Information 

① 

② 

③ 

④ 

⑤ 
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⑦ 

⑧ 

⑨ 

⑩ 

⑪ 

⑫ 

⑬ 

⑭ 

⑮ 

⑯ 

⑰ ⑱ 
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No. Items Descriptions 

⑬ Study Date Indicate the checkup date 

⑭ Institution Name Indicate the name of the institution 

⑮ Study Description Indicate study description 

⑯ Modality Indicate mode 

⑰ OK Close information change form 

⑱ Cancel Close the form of no information change 

 

When loading volume data, it is possible to edit pitch information. 

When loading shape data, it is possible to edit polygon size information. 

 

 
Figure 4.16.2 Situation when pitch can be edited. 

    

 
Figure 4.16.3 Situation when polygon size can be edited 

 

 

4.16.3 Operation Guide 
○ Change pitch 

1. Input number in ④.From the most left side is X, Y, Z 

2. Click ⑰. Close File Information form. After calculating ④ and ⑤，the display of 

cross section and the object of WorkForm will be changed 

 

○ Change polygon size 

1. Input number in ⑥.From the most left side is X, Y, Z 

2. Click ⑰.Close File Information form and the object display of WorkForm will be 

changed 
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4.17 Histogram 

In [window] menu，select [Histogram] or click tool bar . 

 

 

4.17.1 Function Outline 
Display brightness distribution of loaded image data with histogram. 

 

○ Result Handled Case 

Histogram of Head MRI Image 

 

 
Figure 4.17.1 Histogram 
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4.17.2 Screen Description  
 

  
Figure 4.17.2 Histogram 

 

No. Items Descriptions 

①  Histogram Indicate brightness distribution 

②  Display Mode Indicate either Normal (standard form) or, Logarithm (log 

form) 

③  Window Width  Window Width number  

It is illustrated on the graph with light green width 

④  Window Center  Window Center number  

The position is displayed with green line on the graph 

 

 

4.17.3 Setting 
○ Switch between Normal (standard form) and Logarithm (log form) 

When right click on the form, the context menu will appear. 

Select [Normal] from the context menu and histogram will be displayed at Normal form. 

Select [Logarithm], histogram will be displayed at log form. 

 

 

 
Figure 4.17.3 Context Menu 
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Figure 4.17.4 Histogram in log form 
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4.18 Slice View  
From [Window] menu, select [Slice View]. 

 

4.18.1 Function Outline  
Display image in different plane relations like XY, YZ, and XZ. 

But the image in shape data cannot be displayed. 

 

4.18.2 Screen Description  
           

 
Figure 4.18.1 Slice View Form  

 

No. Items Descriptions 

①  File Name  Display loaded file name 

②  XY Plane  

(XY Plane Image) 

Display XY plane image and information 

③  XY Plane 

Position Track Bar 

Specify XY plane position 
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No. Items Descriptions 

④  XY Plane  

Movement Button (-) 

Move the XY plane position towards minus direction 

⑤  XY Plane 

Movement Button(+) 

Move the XY plane position towards plus direction 

⑥  YZ Plane  

(YZ Plane Image) 

Display YZ plane image and information 

⑦  YZ Plane 

Position Track Bar 

Specify YZ plane position 

⑧  YZ Plane 

Movement Button(-) 

Move the YZ plane position towards minus direction 

⑨  YZ Plane 

Movement Button(+) 

Move the YZ plane position towards plus direction 

⑩  XZ Plane  

(XZ Plane Image) 

Display XZ plane image and information 

⑪ XZ Plane 

Position Track Bar 

Specify XZ plane position 

⑫ XZ Plane 

Movement Button(-) 

Move the XZ plane position towards minus direction 

⑬ XZ Plane 

Movement Button(+) 

Move the XZ plane position towards plus direction 

 

○ Inside Image Display 

 

         
Figure 4.17.2 Inside Image Display Information 

 

No. Items Descriptions 

①  Plane Name Indicate type of plane (XY, YZ, and XZ) 

②  Intersection 

Point 

XY,YZ,XZ coordinate of plane intersection 

③  Screen size The maximum value on X, Y, Z bars 
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4.18.3 Operation Guide 
○ If XY plane is moved, the screen display will change. 

1. Move the slide bar of Form 3 from side to side. Use Form 4 and 5 buttons for more 

detailed adjustment 

 

 

          
                     Figure 4.18.3 XY Plane Display 

 

 

○ If YZ plane is moved, the screen display will change 

1. Move the slide bar of Form ⑦ from side to side. Use Form ⑧ and ⑨ buttons for 

more detailed adjustment 

 

 
                   Figure 4.18.4 YZ Plane Display 
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○If XZ plane is moved, the screen display will change 

1. Move the slide bar of Form ⑪ from side to side. Use Form ⑫ and ⑬ buttons for 

more detailed adjustment 

 

                      
                     Figure 4.18.5 XZ Plane Display 

 

○ Replace the displayed screen (when loading multiple data) 

1. Press ① button to replace a file name 

2. Replace WorkForm activity at the same time 

     

○ Display slice editing form (with volume data) 

1. Double click Form ②, or Form ⑥, Form ⑩ 
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4.19 Slice Edit 
Double click the displayed screen in slice form. 

Double click XY plane image, an editing screen will appear corresponding to XY plane, 

Double click YZ plane image, an editing screen will appear corresponding to YZ plane, 

Double click XZ plane image, an editing screen will appear corresponding to XZ plane. 

As for Slicing Display Form, see [4.18 Slice View]. 

 

4.19.1 Function Outline 
Edit slices. 

With single slice and multi slices as objects
*4.19.1

, it is possible to paint pens and rectangles. 

          

*4.19.1 Edited Object 

It refers to slicing within specified scope at single slice mode and 

multi slice mode.  

 

4.19.2 Screen Description 
 

 
 

No. Items Descriptions 

①  Screen  Display the plane image 

②  Pen Drawing Draw pen 

③  Rectangle Drawing Draw rectangle 

④  Dropper Specified color is sucked up 

⑤  Pen Thickness Specify the thickness of pen 

⑥  Multi Slice Mode  

Mode Switch 

Change the slice mode 

⑦  Start Slice Number  Specify the start slice of multi slicing 

⑧  End Slice Number  Specify the end slice of multi slicing 

Figure 4.19.1 Slice Correction Form 
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⑭ 

⑲ 



Volume Extractor Version 3.0 Operation Manual 121 

No. Items Descriptions 

⑨  Painting Brightness  Brightness for corresponding paint 

⑩  Painting Color  Current selecting color 

⑪  Painting Color 

Selection Track Bar 

Select painting color 

⑫  Save Button The contents of edit are applied without closing form 

⑬  Reset Button Abandon edited image 

⑭  Preview 

WindowW/L Mode 

Choose whether to apply WindowW/L with respect to 

the display of ①,⑩,⑪ 

⑮  Screen Minimizing 

Button 
Use ① to minimize the displayed screen 

⑯  Screen Magnifying 

Button 
Use ① to magnify the displayed screen 

⑰  Number Indicating 

Sliced Bar 
Use ① to specify the displayed screen slicing 

⑱  Slice Number  Use ① to display the screen number 

⑲  Fit to Screen If the check is On, to view the entire image on the screen 

⑳  OK Button  Close and apply the edited image 

㉑ Cancel Button Close and cancel the edited image 

 

 

4.19.3 Operation Guide 
 

○ Change image size 

1. Change the size of ⑮ and ⑯. If the size goes beyond the scope of ①, use scroll bar 

in ① to show it 

2. Or right click on ①, the top position is for enlarging and the bottom position is for 

minimizing 

 

○ Change the slice on display 

1. Move the scroll bar in ⑰. On the left is ① while the maximum number is on the right 

2. Or input number into ⑱ 

 

○ Valid the WindowW/L mode 

Add Check box in ⑭. 

 

○ Invalid the WindowW/L mode 

Delete Check box in ⑭. 

 

○ Pen Drawing 

1. Click ② 

2. Use ⑤ to specify thickness of pen 

3. Click on ① and make drawing on it
*4.19.2

 

 

*4.19.2 Points that need attention in pen drawing 

In multi-slicing form, when specifying multi slice within  

the designated scope, the handling takes longer time after  

clicking is done. 
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○ Rectangle painting 

1. Click ④ 

2. On ①，drag the image rectangle painting 

3. Draw the rectangle shape by connecting the starting point and ending point 

 

○ Change single slicing form 

Delete Check box in ⑥. 

     

○ Change into multi slicing form 

Add Check box in ⑥. 

  

○ Change the first slice 

Input number in ⑦. 

 

○ Change the last slice 

Input number in ⑧. 

 

○ Use Dropper Mode 

1. Click ④ 

2. Click on Reading Mode ① 

3. Take color from the area clicked, replace it with the color in Editing Mode ⑨-⑪ 

 

○ Change painting color 

1. Move the Editing Mode ⑪ up and down. Brightness becomes weak at the top while 

brightness becomes stronger at the bottom  

2. And input brightness number into Editing Mode ⑨, the brightness will change 

 

○ Restore the screen to its previous state 

Click [Ctrl+Z] Key. 
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4.19.4 Cut out or extract any shape from the slice screen 
Multiple Primitives can be drawn on the slice screen and can be clipped or extracted 

within the specified range. 

 
No. 項 目 説 明 

① Add Shape Change to [Add Shape] Mode 

Left click to add a point on the screen 

Right click to confirm the shape 

② Clear Shape Delete all shapes on screen 

③ Edit Shape Change to [Edit Shape] Mode 

Move a point on the mouse cursor with left drag 

Right click to delete a point 

Left click with 2 points changed to red, 

add a point between 2 points 

④ Copy Shape Duplicate the shape added just before to the 

current slice image range 

⑤ Reverse Selected 

Range 

Select whether the filling execution range is inside 

the shape or outside, specify the thickness of the 

pen 

⑥ Apply Fills or extracts the range of the specified shape 

⑦ Undo Fold back the result to the previous state 

⑧ Select-Curve Curves shapes for additional operation 

⑨ Select-Polygon Polygons shapes for additional operation 

○  Add Shape 

1. Click  and change to [Add Shape] mode 

2. Click  or  and select to shape type 

3. Each time you left-click on the slice screen, points are added and the line segment 

changes. The more points, the finer the line segment can be adjusted 

4. Right click to confirm the shape and automatically go to [Edit Shape] mode 

 

Figure 4.19.2 Slice Edit Form(AnyShapes) 
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○ Edit Shape 

1. Click  and change to [Edit Shape] mode 

(This operation is unnecessary if it is just after adding a shape) 

2. When you move the mouse cursor to a point, it changes to yellow, so if you drag 

left in this state, you can edit the range of the shape 

 

○ Reverse Selected Range 

1. Click  this will change the execution range of the fill. At this time, only the 

brightly displayed area becomes the extraction range 

 
○ Copy shapes and multi slices 

1. Move to other slice 

2. Click  and duplicate the shape you just added 

(Ex: Add shapes to the 100th sheet, move to the 150th sheet and press the copy 

button, the same shape is duplicated on the 100th to 150th sheets) 

3. After the above operation, as you drag the point to the duplicated shape left drag it 

automatically interpolates and approximates the shape between 

 

○ Perform clipping or extraction with shapes 

1. Press  button to crop or extract each shape 

(With the reversing function , only the part that was brightly displayed is left) 

 

○ Undo result 

1. Press the  button to return the operation to the previous position 
 

 
 

Figure 4.19.3 Add shape, Edit shape, and Reverse selected range 

Figure 4.19.4 Result and Undo Operation 
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4.20 DICOM Manager 
From [Window] menu, select [DICOM Manager]. 

 

4.20.1 Function Outline  
It operates Explorer and is a tool to manage DICOM file. 

It has the following three functions. 

 

○ DICOM Managing Function 

In stratum
*4.20.1

 it manages DICOM data and indicate that stratum. 

It performs display switch, head addition & deletion and sorting. 

 

○ Launch Function 

Send data to Main Frame and WorkForm and display screen. 

 

○ Screen Display Function 

Display the selected DICOM data screen and tag information.  

 

*4.20.1 About DICOM Data Stratification  

Stratify DICOM data automatically according to the following sequence. 

1. Make a list of DICOM data under DICOM Root.(As for DICOM Root 

setting, see [DICOM Manager] in Chapter 6 [Various Setting] ) 

2. Analyze tag information of DICOM data and log onto data base. 

3. The stratified sequence becomes the following:｢(Patient)｣｢(Modality)｣｢

Study date｣ 

4. Display Tree in the dialogue at the sequence in 3. 

 

 In CT/MRI, one check will turn into one dataset which is recognized 

according to tag information in this system. Even if DICOM data file is 

placed in other files, the dataset with a tree structure can still be identified. 
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4.20.2 Screen Description 
○ Main Form 

 

 
 

Figure 4.20.1 DICOM Managing Tool  

 

No. Items Descriptions 

①  Stratum Indication Display DICOM screen in stratum form 

②  Stratum Content Display selected stratum content 

 

○ Context Menu of Main Form 

  

  
 

  Figure 4.20.2 DICOM Context Menu of Managing Tool  

   

No. Items Descriptions 

①  Display  

Display Switch 

of 

Stratum Content 

Switch display modes 

②  Choose 

Columns  

Display Head 

Selection 

Select displayed items in Details of ① 

③  Select All  Turn all the displayed items into selection state 

④  Property  Display screen data in screen display form 

 

① 
② 

① 

② 

③ 

④ 
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○ Column Selection Form 

 

 
 

Figure 4.20.3 Column Selection Form 

 

No. Items Descriptions 

①  Name Display file name or not 

②  Seq No Display management number in Tool or not 

③  Study UID Display Study ID or not 

④  Series UID Display Series ID or not 

⑤  Body Part Display body part or not 

⑥  Accession Number Display accession number or not 

⑦  Institute Display institute number or not 

⑧  Physician Display Physician or not 

⑨  Description Display description or not 

⑩  Series No. Display Series No or not 

⑪ Image No. Display Image Number or not 

⑫ OK  It applies to selected result in main form 

⑬ Cancel Give up content change. Closing Form 
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② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 
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⑫ ⑬ 
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○ Screen Display Form  

 
 

Figure 4.20.4 Screen Display Form 

 

No. Items Descriptions 

①  Screen display  Display the selected screen 

       

 

 

○ Context Menu of Screen Display Form 

 

 
 

Figure 4.20.5 Context Menu of Screen Display Form 

         

No. Items Descriptions 

①  Tag Information 

Switch 

Switch between Having Tag information and No Tag 

Information 

②  Previous  the previous item in the same stratum form 

③  Next  the next item in the same stratum form 

 

 

4.20.3 Operation Description 
○ Stratum Content Switch Display 

1. Right click on Main Form ② and the context menu of Main Form will be opened 

2. Target the cursor at the context menu of Main Form and click the submenu Icon or 

Details 

3. Stratum and image file can be displayed in Icon. The image file is displayed in 

thumbnail and Details are displayed in a form of list 

  

○ Switch List Sort Condition (Only in List Form) 

1. In List Head of Main Form ①, click the item that needs to be sorted 

2. Click it again for reversing the sorting 

   1. In List Head of Main Form ①, click the item that needs to be sorted. 

  2. Click it again for reversing the sorting. 

 

① 

① 

② 
③ 
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○ Display image in screen display form.(pattern:1) 

1. Select the screen to be displayed 

2. Right click and open the context menu of Main Form 

 

○Display image in screen display form.(pattern:2) 

1. Double click the screen to be displayed 

 

○ Tag Information Display on Switch Screen Display Form 

1. Right click on Main Form and the context menu of Main Form will be opened 

2. Click the context menu ① in screen display form 

 

 

○ List Head Addition / Deletion 

1. Right click on Main Form ② to open the context menu of Main Form 

2. Click the context menu ② of Main Form 

3. In column selection form, decide the items to added or deleted 

4. Click column selection form ⑫ 

 

○ Display selected image cluster in volume data 

1. Select a large number of images 

2. Drag or drop them in Main Frame 

 

○ In selected image cluster, switch volume data in WorkForm 

1. Select a large number of images  

2. Drag or drop them in Main Frame  
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4.21 Measuring Function  
Measurement cannot be performed in WorkForm with nothing volume data. 

From [Window] menu, select [Measure Manager], or click tool bar . 

 

 

4.21.1 Function Outline 
It can measure distance, angel and area of each specified line segment, angel and domain in 

WorkForm. It can also measure their volume by means of both Volume Rendering form and 

Index Image form.  

After volume measurement, it can change screen brightness of 3D image filter, segmentation 

and area expansion. When clipping is performed, measurement domain display won’t work. 

 

 

○ One Processed Case  

Domain specification case of cross-segmentation area (As shown in Figure 4.21.1) and the 

measuring result. (As shown in Figure 4.21.2) 

 

 
Figure 4.21.1 Domain specification of segmentation area  
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Figure 4.21.2 Measuring Result  

 

4.21.2 Screen Description 
 

 
       Figure 4.21.3 Measure Manager 

 

No. Items Descriptions 

①  Tub control  Select the type of measurement 

②  Check Box Switch between WorkForm and Non WorkForm 

Display the checked item 

③  Name  Display the name of measuring result 

④  Measuring results Display measuring result 

⑤  Measurement 

selection 

Select the type of measurement 

⑥  Add Key  Display ⑤ 

⑦  Delete Key  Delete the selected measuring result. 

① 

② ③ ④ 

⑤ 

⑥ ⑦ 

⑩ 

⑧ ⑨ 
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No. Items Descriptions 

⑧  Cancel Key Cancel the measurement 

⑨  Save Key Save the measurement result in csv format 

(Measurement division, will include the name, number, the unit) 

⑩  × Key Close Measure Manager form. 

4.21.3 Operation Guide 
○ Measuring distance  

1. Click Add key, select [Distance] 

2. Click on the segmented image and add measurement points  

(As shown in Figure 4.21.4) 

3. Make a right-side click, or click the area around the added points to decide the items to 

be measured. Remember at least two measurement points must be added 

4. Unfold [Distance] of Measure Manager Form, attach measuring result 

 

 
 

Figure 4.21.4 Distance Measurement Points Addition 
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○ Angle Measurement 

1. Click Add key and select [Angle] 

2. Click on the segmented image, add three more measurement points.  

(As shown in Figure 4.21.5) 

3. Unfold [Angle] in Measure Manager form and add measuring result 

 

 
 

Figure 4.21.5 Angle Measurement Points Addition 



Volume Extractor Version 3.0 Operation Manual 134 

○ Area Measurement 

1. Click Add key and select [Area] 

2. Click on the segmented image and add measurement points.
*4.21.1  

(As shown in Figure 4.21.6) 

3. Do click right-side or the vicinity of initially added points to decide the element to be 

measured. More than three measurement points should be added 

4. Unfold [Area] of Measure Manager and add measuring result 

 

 
   

*4.21.1 About Area Measure Points Addition  

In measuring area, use other different color to display added segments.  

Overlapping segments cannot be used for measuring point’s addition. 

 
 

 

 

Figure 4.21.6 Area Measurement Points Addition 
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○ Measuring volume 

1. Click Add key, select [Volume] 

2. Unfold [Volume] of Measure Manager form and add measuring result.
*4.21.2

 

 

*4.21.2 Volume measurement 

Volume measurement will become brightness area specified by 

“Visible” with color tablet displayed by volume. 

As for color tablet displayed by volume, refer to [Volume 

Rendering], [Point-Based Volume Rendering] and [Index Image] 

in Chapter 4 [Function Descriptions]. 

 

○ Delete measuring result
*4.21.3

 

1. Select measuring result to be deleted 

2. Click Delete button 

 

*4.21.3 Things that can be deleted and things that can not be 

deleted 

The Delete button can only delete the measurement input by uses. 

However, it cannot delete measurement type like [Distance] 

      

○ Change measurement name
*4.20.4 

1. Select a measurement name to be changed 

2. Click name 

3. Input a new name 

4. Click Enter button 

 

*4.21.4 Things that can change names or things that cannot 

change names 

Name change is only confined to the measuring result input by the 

user. Measuring type name such as [Distance] cannot be changed. 

 

○ Change measuring point 

1. Select to change measuring point as a measuring result 

2. In WorkForm, drag the measuring point to be changed  

(drag the apex when measuring area) 
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○Cancel the measurement 

1. The user presses the Cancel button 1. During a measurement mode 

 

○Save the measurement result 

1. Pressing the Save button 

2. Specify the file name in the file save dialog, to save (Figure 4.21.7) 
 

 
Figure 4.21.7 display the output of the measurement result 

 

○Change angle of cross section image 

In conjunction with Cross Section, you can perform measurement with respect to the 

inclined section. For more information, please refer to the control form of Chapter 4, "3D 

Cross Section". 

 
 

4.21.4 Setting 
As for display color setting for measurement, refer to [Measure Manager] in Chapter 6  

[Various Setting]. 

 

 

Figure 4.21.8 Conjunction Measure-View and Cross-Section 
 



Volume Extractor Version 3.0 Operation Manual 137 

4.22 WindowW/L 
WindowW/L cannot be used in WorkForm that does not contain volume data. 

In [Window] menu, select [WindowW/L].
*4.21.1

 

 

4.22.1 Function Outline  
WindowW/L is to display the extracted brightness scope through specified window width 

and window level. 

WindowW/L is to display the extracted brightness scope through specified window width 

and window level. 

The contrast becomes weaker when window width is enlarged. On the contrary, the contrast 

becomes stronger when window width is minimized. If window level becomes bigger, the 

screen turns darker and it turns brighter when window level becomes smaller. 

 

○ One Handled Case  

 
Figure 4.22.1 Width: 636, Center: 318 Figure 4.22.2 Width: 200, Center: 318 

 

 
Figure 4.22.3 Width: 636, Center: 131 Figure 4.22.4 Width: 200, Center: 131 

 

*4.22.1 WindowW/L Notation 

It can be called Window setting.  

Besides, "Window Center" is also called Window Level". 
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4.22.2 Screen Description 

 
Figure 4.22.5 WindowW/L Form 

 

No. Items Descriptions 

①  WindowW/L Mode  

Form ON/OFF 

Validize WindowW/L setting 

②  Preset Selection Select for preset parameters. 

③  Window Width  

(Track Bar) 

Specify for window width at the track bar 

④  Window Width 

(Numeric) 

Specify for window width at the numerical text 

⑤  Window Center  

(Track Bar) 

Specify for window level at the track bar 

 

⑥  Window Center 

(Numeric) 

Specify for window level at the numerical text 

 

⑦  Close Button Close the WindowW/L Form 

 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 
① 
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4.22.3 Operation Guide 
○ Set by means of Control key 

Make specification by moving track bar up and down. (Figure 4.22.5 ③-⑥), or by inputting 

correct number and making proper and careful adjustments through image check. 

 

 

○ Make specification by hand on screen 

On the plane section, specify by right clicking the mouse. 

It can adjust window width and window level at the same time, so it is good for visual 

screen observation. 

 

Clicking Direction Number Change 

     Up Decrease Window Center 

     Down Increase Window Center 

     Left Increase Window Width  

     Right Decrease Window Width  

 

○ Change Presetting 

Select from ② of drop down list (As shown in Figure 4.22.5). "Default" of initial setting  

value
*4.22.2

, can be remembered if set by hand, including information in "Bone  

condition""Lungs Field""Mediastinum""Abdominal PLN""AbdominalCE’’ except  

"Custom". 

 

*4.22.2 Initial set value of WindowW/L 

It basically reflects the information quantity of WindowW/L" with DICOM tag.  

When loading data set that does not have "WindowW/L" of DICOM tag, set window 

width and window level automatically from brightness width with volume data. 
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4.23 Screen Capture Function 

Click tool bar ｡ 

 

4.23.1 Function Outline 
Save the active WorkForm on display in an image file with full color (24bit) BMP. 

 

4.23.2 Operation Guide  
○ Save WorkForm status in an image file 

1. Click tool bar , which displays form of saving with a file name 

2. Input the file name and click [Save] key 
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Chapter 5 

Mesh Editing 

Function 
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5.1 Summary 
A feature that is included in the [Mesh Editing] menu, you can edit the mesh data. If you 

select from the menu, "execution of a function" or, "change of mesh editing mode" will be 

performed. However, it will be the end of the operation mode if you select the menu again in 

the mode of running. The current mode can be known from the status bar or check mark, the 

menu. (As shown in Figure 5.1.1) 

The other than function of [Polygon Information] will be forcibly terminated when you 

switch WorkForm. In addition, it becomes the treatment which closed form without 

canceling also when cancellable Confirmation Form is displayed. 

[Filling-Vertex], [Filling-Edge], [Filling-Ring], [Filling-Ring-OuterSelect], 

[Reverse-Manual], and [Delete-Manual] is possible the end of the mode by [Esc] key. 
 

 
 

 

Display Status Mode 

Reconstruction/Reduction  Reconstruction/Reduction (5.2) 

Smoothing Smoothing (5.3) 

Filling- Vertex  Manual filling starting from Vertex (5.4) 

Filling- Edge  Manual filling starting from Edge (5.5) 

Filling- Ring  Manual filling starting from Ring (5.6) 

Filling- Ring-Outer Select  Manual filling from Ring-Outer Select (5.7) 

Reverse-Manual  Reverse-Manual (5.8) 

Delete-Manual  Delete-Manual (5.9) 

Filling-Auto  Filling-Auto (5.11) 

Reverse-Auto  Reverse-Auto (5.12) 

Delete-Auto  Delete-Auto (5.13) 
 

Figure 5.1.1 Mesh Editing Mode 

Now is Reconstruction/Reduction mode 
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5.2 Reconstruction/Reduction  
Select [Reconstruction/Reduction] on [Mesh Editing] menu, and the 

[Reconstruction/Reduction] dialog will be appeared.  

  

5.2.1 Function Outline 
This dialog is used to execute [Reconstruction] or [Reduction] of the polygon. 

Here, [Reconstruction] can improve polygon shape with maintaining the accuracy of the 

polygon, and reduce the number of polygons at the same time. It is suitable to use 3D printer. 

[Reduction] reduce the number of polygons by setting “number of reduction targets”(*5.1) 

of polygon, make the reduction of the polygon shape to be equal to or less than the “number 

of reduction targets”. If you prioritize the use of 3D printer or polygon accuracy, 

[Reconstruction] should be selected. If you prioritize the number of polygons, [Reduction] 

would be fine. 
 

You can use [Undo] button of [Reconstruction/Reduction] dialog to undo the previous 

situation only once. In addition, the [Undo] information will be discarded when the dialog is 

closed. [Undo] button does not work until you perform a [Reconstruction] or [Reduction] 

functions. 

 

*5.1 Number of Reduction targets 

First, [Reduction] function calculates the importance to each polygon. The 

importance means the model feature of polygon shape, and if the value is larger, it 

represents the important characteristics of the polygon model. In [Reduction] 

function, in order to maintain model features, the polygon with lower weight of 

importance will be selected, and deleted firstly. When the polygons have the same 

importance, the polygons will be deleted simultaneously. Therefore, it may be 

different form the number of reduction targets (final target value). 
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○ Result Handled Case 

Select the polygon accuracy "Middle" of the reconstruction result as shown in Figure 5.2.1. 

Select the reduction ratio 20% of the reduction result as shown in Figure 5.2.2. 

 

 

 
 

Figure5.2.2 Result of Polygon Reduction (Before => After) 

Figure5.2.1 Result of Polygon Reconstruction (Before => After) 
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5.2.2 Screen Description  
 

 
 

No. Items Descriptions 

①  Reconstruction 

(Radio Button) 

Select [Reconstruction] mode 

②  Low Configuration in the polygon accuracy "Low" 

→Automatically set to polygon accuracy 6 

Data is small, but accuracy will be lower 

③  Middle Configuration in the polygon accuracy "Middle" 

→Automatically set to polygon accuracy 8 

This is the default setting 

④  High Configuration in the polygon accuracy "High" 

→Automatically set to polygon accuracy 10 

Accuracy is high, but the data will be larger 

⑤  Input check box Select enable or disable the accuracy of manual 

input operation 

Default check is OFF (disabled) 

⑥  Input polygon accuracy ⑤ of the check is ON the case of a (valid), you 

can change the number manually (input range is 

1 to 12) 

⑦  Reduction 

(Radio Button) 

Select [Reduction] mode 

⑧  Reduction Rate Track 

Bar 

Specify reduction rate of polygon number 

⑨  Reduction Rate 

Numeric 

Display reduction rate of polygon number 

Input the number on keyboard 

⑩  The Total Number of 

Polygons 

Display the total number of polygons of model 

data 

⑪  Polygon Reduction 

Numeric 

Display polygon number to be reduced 

Input the number with keyboard  

⑫  Num of Polygon Display current number of polygon triangles 

⑬  Undo Restore polygons in the previous state 

⑭  Execute Execute [Reconstruction] or [Reduction] 

 

Figure 5.2.3 Reduction Form 

① 

④ ③ ② 

⑤ ⑥ 

⑦ 

⑧ 

⑩ 

⑫ 

⑬ ⑭ 

⑪ 

⑨ 
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5.2.3 Operation Guide 
 

○ Change polygon number for reduction according to reduction ratio 

1. Click on the left and move reduction rate track bar from left to right to fix reduction rate 

2. Change the polygon number of reduction to match the reduction ratio 

 

○ Directly change polygon number for reduction 

1. Input the target number into Polygon Reduction Number Box 

2. Change the reduction rate to match the target number 
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5.3 Smoothing 
From [Mesh Editing] menu, select [Smoothing] and smoothing dialog is displayed. 
 

5.3.1 Function Outline 
Execute sampling

*5.2
 on a model, then smoothing process are executed. Undo operation can 

execute only once after smoothing operation. It is recommended to save file trying to 

execute smoothing operation many times. 
 

*5.2 Sampling 

It refers to gather data of particular vertex group in polygons. Smoothing operation 

implements by moving vertexes of polygons, on the occasion of calculating moving 

distance of a certain vertex, it is calculated based on gathered data of neighbor 

vertexes. 
 

○ Result Handled Case 

The smoothing results are below. (As shown in Figure 5.3.1) 
 

 
 

5.3.2 Screen Description 

  
   

No. Items Descriptions 

① Iteration Number Box Display iteration number of smoothing  
operation. Input the number with keyboard 

② Preserve Edge Corner 
Specification 

Check box on when you wish to preserve 
corners of polygons 

③ Wide Sampling Area  
Specification 

Specify extending sampling area or not 

Figure 5.3.1 Smoothed Result 

① 
③ 

④ 

⑤ ⑥ 

⑦ ⑧ 

⑨ 

⑩ 

② 

Figure 5.3.2 Smoothing Dialog 
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④ Parameter Setting 
Specification 

Specify permitting to input smoothing 
parameter or not 

⑤ Smoothness Track Bar Specify smoothness rate of polygon with track 
bar 

⑥ Smoothness Box Specify smoothness rate of polygon with   
keyboard 

⑦ Retain Edge Track Bar Specify retain rate of edge with track bar 

⑧ Retain Edge Box Specify retain rate of edge with keyboard 

⑨ Undo Restore polygons in the previous state 

⑩ Execute(Smoothing) Execute smoothing at the current specification 

 

 

5.3.3 Operation Method 
  

○ Smooth whole model 

1. Input the number into [Iteration Number Box] to set iteration times of smoothing 

operation. A large effect can be expected with increasing iteration times, but there are 

cases which the shape of polygon is very different from original shape of it when too 

large iteration number is given 

2. Click [Wide Sampling Area Check] on and it has an effect to smooth whole model to 

make more even. But there are cases which it has no effect on surface which is nearly 

flat from start 

3. Click [Parameter Setting Check] on and it enables for parameter to be entered. Entering 

the small number into [Smoothness Number Box] reduces the effect of smoothing 

 

○ Smooth retaining angular parts of model 

1. Click [Preserve Edge Corner Check Box] on and smoothing operation is executed in 

preserve corners 

2. Click [Parameter Setting Check] on and it enables for parameter to be entered. The 

smaller number entering into [Retain Edge Number Box], the more angular parts of 

model are preserved when smoothing operation is executed 
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5.4 Manual Filling From Vertex Selection 
From [Mesh Editing] menu, select [Filling-Vertex] to enter a mode of Manual Filling 

Starting from Vertex. 

 

5.4.1 Function Outline 
Choose three vertexes to make a new polygon.  

The outside and inside of the new polygon is determined by its selected sequence.
*5.3

 

 

*5.3 Selected Vertex Sequence 

When selecting vertex in clockwise way, it becomes a polygon 

facing outward. When selecting vertex in anti-clockwise way, it 

becomes a polygon facing inward. (As shown in Figure 5.4.1) 

 

    
          Outside                     Inside     

Figure 5.4.1 Polygon Facing 

 

 

○ Result Handled Case 

  Filling Case (As shown in Figure 5.4.2) 

 

   
Figure 5.4.2 Filling Case  

 

3 

1 

2 

1 

2 

3 
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5.4.2 Operation Guide 
○ Select Vertex 

Press [Shift] key and click the left to select vertex. The selected vertex turns into the 

specified color.
*5.4

 

 

*5.4 Specified Color 

The color of vertex, edge and polygon should all be 

specified for change. 

As or color specification, refer to [Mesh Editing Function] 

in Chapter 6 [Various Setting]. 

 

○ Terminate Filling Mode half way 

Select [Filling-Vertex] from [Mesh Editing] menu in vertex selection. 

 

○ Restore filling to the original status. 

Press [Ctrl+Z] key or select [Undo Edited] from [Mesh Editing] menu. 
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5.5 Manual Filling From Edge Selection 
From [Mesh Editing] menu, select [Filling-Edge] to enter a mode of Manual Filling from 

Edge. 

 

5.5.1 Function Outline 
Select open edges

*5.5
 that makes holes of model data for one more time filling. 

 

*5.5 Open Edge 

Open edge refers to the edge that is not adjacent to polygons. Any 

hole and polygon edge of model end are open edge. 

 

○Result Handled Case 

Filling Case (As shown in Figure 5.5.1) 

 

  
 

Figure 5.5.1 Hole Filling Case 
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5.5.2 Operation Guide 
○ Make Filling 

1. Press [Shift] key and click the left side to select open edge for filling. Confirm the mode 

2. After confirmation, click [Execute] key and click [Cancel] for canceling 

 

 

 
 

      Figure 5.5.2 Mode Confirmation  

 

○ Reverse the filled polygon 

In confirmation mode, click [Reverse] key and replace the inside of the polygon with the 

outside of polygon.  

 

○ Terminate hole-filling mode half way 

Before selecting open edge, select [Filling-Edge] from [Mesh Editing] menu.  

After filling is finished, click [Cancel] key in confirmation mode of Filling –Edge. 

          

○ Restore the filled shape to its original status. 

Press [Ctrl+Z] key, or select [Undo Edited] from [Mesh Editing] menu. 
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5.6 Manual Filling From Ring Selection 
From [Mesh Editing] menu, select [Filling-Ring] to enter a mode of Manual Filling from 

Ring Selection 

 

5.6.1 Function Outline 
It makes filling through selecting rings.

*5.6
 In selecting rings, make the longest ring as the 

outside so that other smaller rings cannot change into polygons. If the outside ring is shorter 

than other inside rings, see [5.6 Manual Filling Outside the Ring]. 

 

*5.6 Ring 

It refers to link of open edge that makes a polygon. 

 

○ Result Handled Case 

Filling Result (As shown in Figure 5.6.1) 

 

  
 

Figure 5.6.1 Filling Result 
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5.6.2 Operation Guide  
○ Making Filling 

1. Press [Shift] key and click on the right mouse key. After one ring is selected,  

a confirmation window will come up. At this time, [Execute] does not work. And filling  

cannot be done. (As shown in Figure 5.6.2) 

 

  
 

Figure 5.6.2 Filling Result 

 

2. When the next ring is selected, [Execute] in confirmation mode will work and filling 

can be executed. (As shown in Figure 5.6.3) 

 

 
 

Figure 5.6.3 Select the next ring 

 

○ Reverse filled polygon 

In confirmation window mode that comes up after filling, click [Reverse] button and reverse 

the filled polygon. 

 

○ Terminate Filling Mode 

Before selecting a ring, select [Filling-Ring] from [Mesh Editing] menu.  

Click [Cancel] key in confirmation window mode to cancel filling 

 

○ Restore filled polygon to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 

 

Invalid 

Selected one ring 

Valid Button 
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5.7 Manual Filling From Outer Ring Selection 
From [Mesh Editing] menu, select [Filling-Ring-Outer Select] and enter mode of 

filling-ring-outer selection. 

 

5.7.1 Function Outline 
It performs multi ring filling. If the first selected ring is outside the shape, make a polygon 

without having the edge overlap other edges. Selecting outer ring is different from what is 

described in [5.6 Manual Filling From Ring Selection]. 

 

○ Result Handled Case  

Filling Case (As shown in Figure 5.7.1) 

 

  
 

Figure 5.7.1 Filling Result 
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5.7.2 Operation Guide 
○ Make Filling 

1. Press [Shift] key and click at the left to select the most outward ring. Then a 

confirmation form will come up. At this time, [Execute] does not work. And filling 

cannot be done (As shown in Figure 5.7.2) 

 

  
Figure 5.7.2 Selecting Outer Ring 

     

2. When the next inner ring is selected, [Execute] in confirmation mode will work and 

filling can be executed. (As shown in Figure 5.7.3) 

 

 
Figure 5.7.3 Selecting Inner ring Rings 

 

○Reverse filled polygon 

In confirmation mode that comes up after filling, click [Reverse] button and switch  

the inside and outside of the filled polygon. 

 

○Terminate Filling Mode half way 

Before selecting edge, select [Filling-Ring-Outer Select] from [Mesh Editing] menu. Click 

[Cancel] button in confirmation mode when selecting one more edge. 

 

○ Restore filled polygon to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 

Invalid 

Select the out ring 

Valid Button 
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5.8 Manual Reversion 
From [Mesh Editing] menu, select [Reverse-Manual] and enter manual reversions mode. 

 

5.8.1 Function Outline 
Select polygons and reverse the inside out. 

 

○ Result Handled Case 

Reversion Case (As shown in Figure 5.8.1) 

 

 

  
 

Figure 5.8.1 Reversed Results 

 

 

5.8.2 Operation Guide 
○ Make reversion 

Press [Shift] key and click at the left key to select the polygon to be reversed. 

 

○ Terminate reversion mode half way 

Select [Reverse-Manual] from [Mesh Editing]. 

         

○ Restore the reversed object to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 
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5.9 Manual Deletion 
Select [Delete-Manual] from [Mesh Editing] menu and enter Manual Delete Mode. 

 

5.9.1 Function Outline 
Select polygons for deletion. 

      

○ Result Handled Case 

Deletion Case (As shown in Figure 5.9.1) 

     

  
Figure 5.9.1 Deletion Result 

 

5.9.2 Operation Guide 
 

○ Perform Deletion 

Press [Shift] key and click at the left key to select the polygon to be deleted. 

 

○Terminate manual deletion half way 

Select [Delete-Manual] from [Mesh Editing]. 

 

○ Restore the deleted object to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 
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5.10 Auto Modification 
From [Mesh Editing] menu, select [Auto-Modification] to enter a mode of Auto Modification. 

 

5.10.1 Function Outline 
"Auto Filling", "Remove duplicates-face", "Auto Delete" is executed in the order. A check 

mark is displayed in the [Auto-Modification] is on the menu, but the mode display on the 

status bar will be [Delete-Auto]. Also, become subject to undo only [Delete-Auto]. If you 

exit without performing the delete, [Undo Edited] is disabled state. 

 

5.10.2 Operation Guide 
○Execution 

It will perform, if [Auto-Modification] is chosen from the [Mesh Editing] menu, and finally 

Auto Deletion Modes is display. Please refer to the section "5.13 Auto Deletion" for a 

description of the Auto Deletion Form. 
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5.11 Auto Filling 
From [Mesh Editing] menu, select [Filling-Auto] and enter auto filling mode. 

 

5.11.1 Function Outline 
Automatically check out holes of model data and perform filling. 

 

○ Result Handled Case 

Filling Case (As shown in Figure 5.11.1) 

 

  
Figure 5.11.1 Filling case 

 

5.11.2 Operation Guide  
○ Perform Filling 

Click [Execute] key in confirmation mode that comes up after filling. 

 

 
Figure 5.11.2 Confirmation Form  

 

○ Delete Filling Result 

Click [Cancel] key in confirmation mode that comes up after filling. 

 

○ Restore the filled object to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 
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5.12 Auto Reversion 
From [Mesh Editing] menu, select [Reverse-Auto] and enter Auto Reversion Mode. 

 

5.12.1 Function Outline 
It can automatically reverse the polygon’ inside outward. If the inside and outside reversion 

fails
*5.7

, refer to [5.8 Manual Reversion]. 

   

*5.7 Failure Case of Inside and Outside Reversion 

Failure occurs if the inside and outside of surrounding 

polygons are mixed up. 

 

○ Result Handled Case 

Reversion Case (As shown in Figure 5.12.1) 

 

  
Figure 5.12.1 Reversion Result  

 

5.12.2 Operation Guide 
 

○ Perform Reversion  

Click [Execute] key in confirmation mode that comes up after reversion.  

 

 
Figure 5.12.2 Confirmation Form 

 

○ Delete Reversion Result 

Click [Cancel] key in confirmation mode that comes up after reversion.  

 

○ Restore the reversed object to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 
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5.13 Auto Deletion 
From [Mesh Editing] menu, select [Delete-Auto] and enter auto deletion mode. 

 

5.13.1 Function Outline 
Divide polygon chuck of model data into groups and perform deletion by group.  

 

○ Result Handled Case 

Deletion Result (As shown in Figure 5.13.1) 

 

  
 Figure 5.13.1 Deletion Result 

 

Delete the polygon 

Inside the red ring 
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5.13.2 Screen Description 
 

 
Figure 5.13.2 Auto Deletion Form 

 

No. Items Descriptions 

① Group  

(Polygon Group No List) 

Display polygon group number in sequence 

② Number  

(Polygon Number List) 

Display the number of polygons in each group 

③ Threshold of Polygon 

Polygon Number 

Threshold Track Bar  

Specify the threshold of polygons 

Polygon group under the specified threshold will 

enter selection status in a list 

④ Polygon Number Box Specify the threshold of polygons 

Polygon group under the specified threshold will 

enter selection status in a list 

⑤ Execute Deletion Delete polygon group selected from the list 

 

① ② 

③ ④ 

⑤ 
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5.13.3 Operation Guide 
○ Select polygon group 

Select the group to be deleted in the polygon group list (As shown in Figure 5.13.3). The 

display of selected polygon group will change in WorkForm. Press [Ctrl] key and click the 

left key at the same time to make multiple selection. 

 

  
 

  
 

   Figure 5.13.3 Polygon Group Selections 

 

Select a polygon group 
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○ Select polygon group with threshold of polygon 

Change threshold with the threshold track bar. Polygon group under the specified threshold 

will enter selection status in a list. (As shown in Figure 5.13.4) 

 

  
 

  
  

 Figure 5.13.4 Threshold Change 

 

○ Restore the deleted object to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 

 

 

○ Extract only the required polygon group 

1. Enter a low value, such as thresholds 100 directly, the group needed to confirm that not 

highlighted on the work form, (not selected) 

2. After determining the threshold, and then press the Execute button 

3. The remaining one group was to select only unwanted group from the list, press the 

Execute button again (if unnecessary groups is large, repeat 1-2 step first) 

4. Repeat 1 to 3, and close the dialog, leaving only the required groups 

 

 

 

Change the value 
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5.14 Total Reversion 
Select [Reverse-All] from [Mesh Editing] menu. 

 

5.14.1 Function Outline 
Reverse all of the polygons. 

  

○ Result Handled Case 

Total Reversion Result Display. (As shown in Figure 5.14.1) 

 

  
Figure 5.14.1 Result of Reversing All 

 

 

5.14.2 Operation Guide 
 

○ Perform All Reversion 

From [Mesh Editing] menu, select [Reverse-All]. 

 

○ Restore reversion result to its original status. 

Press [Ctrl+Z] key at the same time or select [Undo Edited] from [Mesh Editing] menu. 
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5.15 Undoing 
From [Mesh Editing] menu, select [Undo Edited]. 

 

5.15.1 Function Outline 
Record the information of filling, reversion and deletion into the buffer for future restoration. 

Undoing is using the recorded information to restore the operation to the original.  

The buffer is cleared when performing different type operation.
*5.8

 

 

*5.8 Different Type Operation 

Meshing editing function is classified into four kinds: reduction, 

filling, reversion and deletion. 

・Reduction 

・Filling: Manual Filling of all kinds and Auto Filling 

・Reversion: Manual Reversion, Auto Reversion, Reversing All  

・Deletion: Manual Deletion, Auto Deletion 

 

For example, Auto Reversion and Manual Reversion can be undone. However, the last auto 

reversion cannot be undone when other operations such as manual deletion are under way. 

 

 
Figure 5.15.1 Operation and Undo buffer 
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5.16 Propriety Check 
From [Mesh Editing] menu, select [Propriety Check] to display Propriety Check mode.  

(As shown in Figure 5.16.1) 

 

5.16.1 Screen Description 

 
 

Figure 5.16.1 Propriety Check Form 

 

 

No. Items Descriptions 

①  Repeated Error Retrieving  

Specification 

(Duplicate)  

Specify retrieving of repeated error of vertex, edge and 

polygon or not
*5.9

 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

repeated error retrieving possible 

②  Repeated Error Vertex 

Retrieving Specification 

 (Duplicate- Vertex)  

Specify retrieving of repeated error of vertex or not 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

repeated error retrieving possible 

③  Repeated Error Edge  

Retrieving Specification 

(Duplicate-Edge) 

Specify retrieving of repeated error of edge or not 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

repeated error retrieving possible 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ ⑨ 

⑩ 

⑪ 

⑬ ⑫ 

⑭ 

⑮ 

⑯ 

⑰ 

⑲ 

⑱ 

⑳ 

㉒ ㉑ 
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No. Items Descriptions 

④  Repeated Error Polygon   

Retrieving Specification 

 (Duplicate-Polygon) 

Specify retrieving of repeated error of polygon or not  

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

repeated error retrieving possible 

⑤  Repeated Error Vertex No. Display Repeated Error Vertex No. 

⑥  Repeated Error Edge No. Display Repeated Error Edge No. 

⑦  Repeated Error Polygon No. Display Repeated Error Polygon No. 

⑧  Repeated Error Retrieving Perform Repeated Error Retrieving 

⑨  Repeated Error Correction Perform Repeated Error Correction(Deletion) 

⑩  1Vertex-2 Edge Continuous 

Error Retrieving  

Specification 

(1 Vertex - 2 Edge ) 

Specify retrieving of continuous error of 1Vertex-2 Edge 

or not
*5.10

 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

error retrieving possible 

⑪ Polygon Number of 

1Vertex-2 Edge Continuous 

Error  

Display the number of polygon made up of 1Vertex-2 

Edge and continuous error vertex 

⑫ 1Vertex-2 Edge Continuous 

Error Retrieving  

Perform1Vertex-2 Edge Continuous Error Retrieving 

⑬ 1Vertex-2 Edge Continuous 

Error Correction 

Perform1Vertex-2 Edge Continuous Error 

Correction(Deletion) 

⑭ 1Edge-2Polygon 

Continuous Error 

Specification 

 (1Edge-2Polygon) 

Specify retrieving of continuous error of 

1Edge-2Polygon or not
*5.11

 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

repeated error retrieving possible 

⑮ Edge Number of 

1Edge-2Polygon 

Continuous Error 

Display the edge number of 1Edge-2Polygon continuous 

error 

⑯ Polygon Number of 

1Edge-2Polygon 

Continuous Error  

Display the number of polygon made up of edges of 

1Edge-2Polygon continuous error 

⑰ 1Edge-2Polygon 

Continuous Error Retrieving  

Perform 1Edge-2Polygon Continuous Error Retrieving 

⑱ 1Edge-2Polygon 

Continuous Error 

Correction 

Perform 1Edge-2Polygon Continuous Error Correction 

(Deletion) 

⑲ Specify Normal Error 

Retrieving 

(Normal) 

Specify retrieving of normal error or not
*5.12

 

Specify error display or non-display. With Check on, 

mesh editing can be performed, thus making automatic 

error retrieving possible 

⑳ Polygon Number of Normal 

Error 

Display Polygon Number of Normal Error 

 

㉑ Normal Error Retrieving Perform Normal Error Retrieving 

㉒ Normal Error Correction Perform Normal Error Correction(reversion) 

      

*5.9 Repeated Error of vertex, edge and polygons 

Repeated Error of vertex refers to the repeated vertex in the coordinate.  

Repeated Error of edge refers to the edge made up of two same vertexes. 

Repeated Error of polygons refers to the polygon made up of three same edges. 

 



Volume Extractor Version 3.0 Operation Manual 170 

*5.10  1Vertex-2 Edge Continuous Error 

The vertex that makes normal model must have three edges 

connected, in which case retrieving can be executed...   

 (As shown in Figure 5.16.2). The vertex that does not conform will 

become an error. (As shown in Figure 5.16.3). When the polygon 

with unsuitable vertex becomes a starting point of the model, holes 

will appear. 

 

 
        Figure 5.16.2 Edge Number of Vertex Linking 

 

 
Figure 5.16.3 1Vertex-2Edge Continuous Error Case Retrieving  

          

*5.11  1Edge-2Polygon Continuous Error 

A normal edge for retrieving must have two successive 

polygons. Otherwise, it is considered as an error.  

If three polygons share one edge, it is also an error. 

 

  
      Figure 5.16.4 Case of 1Edge-2Polygon Continuous Error 
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*5.12 Normal Errors 

The outside of polygon (normal facing) has the following facings. 

.anti-clockwise: facing outward 

clockwise: facing inward (As shown in Figure 5.16.5) 

If two adjacent polygons have the same facing, the edge shared by the 

two polygons should face different directions. If not, that is an error.  

 (As shown in Figure 5.16.6) 

    

 
Figure 5.16.5 Edge Facing and Polygon Facing 

 

 
Figure 5.16.6 Facing Direction of Shared Edge 
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5.16.2 Operation Guide 
○ Repeated Error Retrieving 

1. Click [Duplicate Check] on, the retrieved element like [Vertex], [Edge], and [Polygon] 

should be on working status. And then click [Check] button to start retrieving 

2. Use green color to display the error element (As shown in Figure 5.16.7) 

3. If [Duplicate Check] is clicked off, error display of Vertex], [Edge], [Polygon] will 

disappear 

 

 
Figure 5.16.7 Repeated Error Polygon Display 

 

○ Repeated Error Correction 

1. After error retrieving, use [Fix] button for correction 

2. Once correction is finished, automatic error retrieving will be performed 

3. If the error of vertex, edge and polygon become zero, correction will be repeated 

 

○ Error Retrieving of 1Edge-2 Edge 

1. Click [1 Vertex – 2 Edge Check] on and use [Check] button for retrieving 

2. Use purple to display polygons made up of error vertexes. (As shown in Figure 5.16.8) 

3. If [1 Vertex – 2 Edge Check] is clicked off, error display will disappear 

 

 
 

Figure 5.16.8 Continuous Error of 1 Vertex – 2 Edges 

 

○Continuous Error Correction of 1 Vertex – 2 Edge 

1. Click [1 Vertex – 2 Edge Check] on and use [Check] button for retrieving  

2. Use purple to display polygons made up of error vertexes  

3. If [1 Vertex – 2 Edge Check] is clicked off, error display will disappear  

 

○ Continuous Error Correction of 1 Vertex – 2 Edges 

1. After retrieving continuous error of [1 Vertex – 2 Edge Check],  use [Fix] for 

correction, which means deleting polygons with wrong vertexes 

2. Once correction is finished，automatic error retrieving will be performed 

3. Auto filling will be done to those holes. Polygon reversion will also be done if needed 
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○ Continuous Error Correction of 1 Vertex – 2 Edges 

1. Click [1 Vertex – 2 Edge Check] on and use [Check] button for retrieving 

2. Use red color to display error edge and yellow color to display polygons made up of 

error edge. (As shown in 5.16.9) 

3. If [1 Vertex – 2 Edge Check] is clicked off, error display will disappear 

 

 
Figure 5.16.9 Display of Continuous Error Correction of 1 Vertex – 2 Edges 

 

○ Continuous Error Correction of 1 Vertex – 2 Edge 

1. After retrieving continuous error of [1 Vertex – 2 Edge Check], use [Fix] button for 

correction, which means deleting polygons with wrong edges 

2. Once correction is finished，automatic error retrieving will be performed 

3. Auto filling will be done to those holes. Polygon reversion will also be done if needed 

 

 
Figure 5.16.10 Continuous Error Correction of 1 Vertex – 2 Edges 

 

 
Figure 5.16.11 After one filling is executed. 

 

 
Figure 5.16.12 Reverse after filling is all done. 
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○ Normal Error Check 

1. Click [Normal Check] on and use [Check] button for retrieving 

2. Use the red color to display error polygon 

3. If [Normal Check] is clicked off, error display will disappear 

 

○Normal Error Correction 

1. After checking normal errors, use [Fix] button for correction 

2. Once correction is finished, automatic error retrieving will be performed 

3. It the error number turns to zero (0), repeated correction will be performed again.  

But the error covers other areas other than the normal error, it won’t turn to zero 

                       

 
Figure 5.16.13 Normal Error Retrieving and Correction 
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5.17 Polygon Information 
From [Mesh Editing] menu, select [Polygon Information] for displaying edited polygon 

information. (As shown in Figure 5.17.1) 

     

5.17.1 Screen Description 
 

 
 

 

No. Items Descriptions 

①  Vertex Number Display vertex number 

②  Edge Number Display edge number 

③  Polygon Number Display polygon number 

 

 

Figure 5.17.1 Polygon Information Form 

① 

② 

③ 
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Chapter 6 

Various Setting 
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6.1 Application Preferences 

From [Tools] menu, select [Preference] or click tool bar . 

 

6.1.1 Function Outline 
Specify display color and initial value. 

 

6.1.2 Screen Description  
Setting Specification Mode 

 

 
Figure 6.1 Setting Specification Modes 

 

 

 

 

 

 

 

 

          

No. Items Descriptions 

①  Specified Item List Display the specified item list 

②  Specified Content Display the specified content related to specification 

③  OK Button This button is used for changing and closing 

④  Cancel This button is used for change canceling and closing 

⑤  Accept Button It is used for changing and continuous performance 

② 

③ ④ ⑤ 

① 
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○ Item『General』 

 

 
Figure 6.2 General Item 

 

 

No. Items Descriptions 

① Default Pitch  Indicate the initial value of pitch 

This feature is used in the Raw file input 

② Default Polygon Scale  Indicate the initial value of polygon size 

This feature is used in the STL file input 

③ Language Switch the application language settings. 

Japanese and English are available. 

② 

① 

③ 
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○ Item『WorkForm Initialize』 

 

 
Figure 6.3 WorkForm Initialize Item 

 

 

 

No. Items Descriptions 

① Default View Model  Specify display of model after data loading 

② Guide Type  Specify guide type in WorkForm 

③ Guide Size Specify guide size 

④ Face Color  

(Surface Color) 

Specify the guide surface color 

⑤ Edge Color  

(line color) 

Specify the guide’s line color 

② 

③ 

④ 

⑤ 

① 



Volume Extractor Version 3.0 Operation Manual 181 

○ Item『Region Growing』 

 

 
Figure 6.4 Region Growing Item  

 

No. Items Descriptions 

①  Region Color  Indicate the color of expanded object 

②  Default Seed Color Indicate SEED color 

③  Selected Seed Color  Select the color in SEED list 

① 

② 

③ 
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○ Item『Iso-Surface』 

 

 
 

No. Items Descriptions 

① Constant C  Indicate Constant C 

② Reduction  Indicate initial value of reduction rate 

③ Front Side Color  Indicate the fore color of polygons 

④ Back Side Color  Indicate the back color of polygons 

⑤ Contour Color 

 

2D preview color of contour 

⑥ File Export Mode The coordinate system at the time of 

outputting a STL file is specified 

Notes: As for "Center" and "Image", the 

center of a three-dimensional picture and 

the lower left of a three-dimensional picture 

serve as the starting point 

"-- DICOM --" -- the starting point 

specified by the DICOM coordinate system 

turns into the starting point 

Each coordinate value is a world 

coordinates system, and serves as the same 

scale altogether 

⑦ Iso-Surface 

Algorithm 

The generation method of an equivalence 

side is chosen from a marching cube 

method or the marching Tetrahedra method 

(4th page physique child method) 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

Figure 6.5 Iso-Surface Items 
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○ Item『Mesh Editing』 

 

 
Figure 6.6 Mesh Editing Item  

 

 

No. Items Descriptions 

①  Vertex Color   Display vertex color in WorkForm 

②  Selection Color  Display the selected color 

③  Edge Color  Display the edge color of polygon in WorkForm 

④  Open Edge Color  Display the open edge color in WorkForm 

⑤  Normal Color  Display the normal color in WorkForm 

⑥  Result Color  Display the result color in WorkForm 

⑦  Normal Length  Display the normal length in WorkForm 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 
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○ Item『Volume Rendering』 

 

 
Figure 6.7 Volume Rendering Item  

 

No. Items Descriptions 

①  Texture Type  Indicate the texture type to be used 

②  Resolution  Indicate texture resolution 

③  Compress This sub-menu lets you specify whether to use a compressed 

texture volume rendering 

Texture Type is 3D, I can be used when 32 to 512 Resolution 

④  Auto / File  

(Radio Button) 

Specifying transfer function default of Point-Based Volume 

Rendering by selecting Volume Rendering from [Auto] or [File] 

⑤  Default 

Transfer function 

List 

Selecting shape of the transfer function graph of volume rendering. 

When you select a Modality, to determine the type automatically 

when you load the DICOM image 

⑥  Default 

Transfer function 

File 

Specifying transfer function of the default of the volume rendering 

⑦  File Opening 

Button 

File selection dialog to select the transfer function of the default 

opens 

⑧  Color / File 

Radio Button 

Selecting "Color" from the "File" the default settings of the transfer 

function graph of index image 

⑨  Min Color  

(Index Image  

Minimum 

Brightness ) 

Indicate the minimum brightness of index image 

⑩  Default  

Index Image File 

Specifying the transfer function of the default of the index image 

⑪  File Opening 

Button 

Open the DIALOG of default transfer function file selection 

(Index Image) 

⑫  Histogram Line 

Color 

Paint histogram line color 

⑬  Alpha Line Color Paint color between the initial values 

① 

② ③ 

④ 

⑤ 

⑥ 

⑧ 

⑨ 

⑩ 

⑬ 

⑭ 

⑫ 

⑯ 

⑦ 

⑪ 

⑮ 
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No. Items Descriptions 

⑭  Preset Folder Specify folders containing list of various forms such as volume 

rendering, point-based volume rendering and index image 

⑮  File Opening 

Button 

Open the DIALOG of the specified file 

⑯  Shading 

Brightness 

Specifying intensity of the light at the time of shading 
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○ Item『Measure Manager』 

 

 

 

No. Items Descriptions 

①  Distance Color  Indicate the display color of measured distance 

②  Angle Color  Indicate the display color of measured angle 

③  Area Color  Indicate the display color of measured area 

④  Opacity  Indicate the transparency of measured area 

⑤  Reference Color  Indicate reference color 

⑥  Moving Color  Indicate moving color of measurement 

⑦  Selected Color  Indicate selecting color on measurement list 

⑧  Coordinate Display Indicate selecting coordinate color of distance start point 

and end point 

⑨  Unit System Indicate the unit of measurement results 

① 

② 

③ 

⑤ 

⑥ 

⑦ 

④ 

Figure 6.8 Measure Manager Item 

⑧ 

⑨ 
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○ Item『DICOM Manager』 

 

 
Figure 6.9 DICOM Manager Item  

 

 

 

 

 

 

 

 

 

 

No. Items Descriptions 

①  DICOM Root 

Folder  

Indicate the folder route of DICOM managing tool 

②  Browse  

(Folder Reference) 

Open the selection form of window standard folder 

③  Patient Check 

 

When loading DICOM images, specify whether to 

check the patient’s information(name, birthday, gender, 

modality and checking date) 

④  DICOM Tag Check  When loading DICOM images, specify whether to 

check the following items 

.Study Instance UID 

.Series Instance UID 

.Series Number 

⑤  Image Sorting ID  When reading DICOM images, specify whether the 

standard sort of slice 

Slice 

Position  

Sort by a slice position (asc) 

(Default) 

Image 

Number 

Sort by an image number (asc) 

⑥  Image Direction When reading DICOM images, specify whether the 

row order of slice are reversed 

As-is  Not Reversed (Default) 

reverse Z  Reversed 

① 

② 

③ 

④ 

⑤ 

⑥ 
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○ Item『Wireframe Color』 

 

  

 

 

 

No. Items Descriptions 

①  Default Box Color  Specify area color of 3D image 

②  Clipped Area Color  Specify the outline color in Clipping WorkForm 

③  Voxel Paint Color  Specify the outline color in Voxel Paint WorkForm 

④  Volume Carving 

Color  

Specify the outline color in Volume Carving WorkForm 

⑤  Cross Section Color Specify the outline color in Cross Sections WorkForm 

⑥  Mask Area Color Specify the outline color in Volume Segment WorkForm 

① 

② 

③ 

④ 

⑤ 

Figure 6.10 Wireframe Color Item 

⑥ 
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6.1.3 Operation Guide  
○ Create the Iso-Surface by MarchingTetrahedra method 

1. Click [Iso-Surface] in Setting Mode ① 

2. From radio button ② item [Iso-Surface Algorithm]. 

  Select the [MarchingTetrahedra] and apply 

3. Create the Iso-Surface by the『Iso-Surface』dialog 

 

○ Change the Volume Rendering texture type 

1. Click [Volume Rendering] in Setting Mode ①. 

2. Change the value of any ② item [Resolution] and apply 

3. Check the volume rendering of ③ WorkForm 

 

○ Preset settings folder of the Transfer Function 

1. Click [Volume Rendering] in Setting Mode ① 

2. Enter the path to item [Preset Folder] or press the [...] button,  

  select the folder from the form and then select the target folder 

3. If there is a .rpf file in the folder that was ③ Settings on the left side  

  of the various rendering form. It appears as a preset of the transfer function. 

 

○ Change DICOM Root Folder 

1. Click [DICOM Manager] in Setting Mode ①. 

2. Setting Mode ② turns into [DICOM Manager]. 

3. Input root folder into [DICOM Manager] ① or click [DICOM Manager] ②  

  and select the folder in folder selection mode. 
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Appendix  
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7.1 Message Display  
In VolumeExtractor3.0, application message display can be switched between Japanese and 

English. 

 

7.1.1 How to switch message display between Japanese and English 
(※ Attention) This operation does direct editing directly, so the file backup must be 

obtained. 

 

1. Confirm if the Volume Extractor 3.0 has got started or not. 

 

2. Open the documents folder. 

As usual, the installment is performed at the following location. 

 

C:\Users\<UserName>\Documents\i-Plants\Volume Extractor 3.0 

 

3. Select "Settings.xml" in the folder. 

*The file backup must be obtained. 

 

4. Open "Settings.xml" Change <Language> into the desired value. 

  "ja" : Japanese 

  "en": English 

 

5. Save "Settings.xml" and close this file. 

 

6. Start Volume Extractor 3.0 and confirm the displayed message. 
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